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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross 
Technology. 
Our mission is to:
1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach 
out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality 
customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to 
guide our behavior:
1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong 
and it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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Introduction
This guide covers the installation, configuration, and use of the softGear Streaming Gateway. The 
following chapters are included:

• “Introduction” summarizes the guide and provides important terms, and conventions.
• “Before You Begin” summarizes the features of the Streaming Gateway.
• “Integration Examples” provides workflow examples for the Streaming Gateway integration.
• “Hardware Overview” presents information on the features of the front and back panels of the 

Streaming Gateway chassis.
• “Physical Installation” provides additional information needed for installing the Streaming 

Gateway and DashBoard before you can proceed to cabling and configuring your Streaming 
Gateway.

• “Cabling” outlines how to connect to your facility network, and peripheral devices.
• “Initial Connection” provides instructions for configuring the initial IP address for the Streaming 

Gateway.
• “Licensed Features” outlines the available software licensed features, and how to install and 

uninstall a software key for a licensed feature.
• “Updating the Network Settings” provides instructions for configuring the 1G port of the 

Streaming Gateway for communication with your facility network and NTP server.
• “Using DashBoard” provides instructions for launching DashBoard, and accessing the Streaming 

Gateway interfaces in DashBoard.
• “Connections” outlines how to configure the connections for your Streaming Gateway, and then 

enable the connections.
• “Upgrading the Software” provides instructions on how to upgrade the Streaming Gateway 

software via DashBoard.
• “DashBoard Interface Overview” summarizes the menus and parameters of the Streaming 

Gateway tabs in DashBoard.
• “Technical Specifications” provides the specifications for the Streaming Gateway.
• “Service Information” provides information on the warranty and repair policy for your 

Streaming Gateway.
• “Glossary” provides a list of terms used throughout this guide.
• “Third Party Licenses” contains licenses for third party libraries that are used in the softGear 

Streaming Gateway.

Related Publications
It is recommended to consult the following Ross documentation before installing and configuring 
your Streaming Gateway:

• DashBoard User Manual, Ross Part Number: 8351DR-004
• Streaming Gateway Quick Start Guide, Ross Part Number: 3900DR-506
• Streaming Gateway Cloud Installation Guide, Ross Part Number: 3900DR-507

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user 
must enter, or a sequence of menus and sub-menus that must be followed to reach a particular 
command.
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Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For 
example:

In the Network tab, click Apply.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Text set in bold and italic represent the titles of referenced guides, manuals, or documents. For 
example:

For more information, refer to the DashBoard User Manual.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. 
For example, if a step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

 Contact your IT department before connecting to your facility network to ensure that there are 
no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and 
Gateway for your device.

Contacting Ross Video Technical Support
At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as 
the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. 
After-sales service and technical support is provided directly by Ross Video personnel. During 
business hours (Eastern Time), technical support personnel are available by telephone. After hours 
and on weekends, a direct emergency technical support phone line is available. If the technical 
support person who is on call does not answer this line immediately, a voice message can be left 
and the call will be returned shortly. This team of highly trained staff is available to react to any 
problem and to do whatever is necessary to ensure customer satisfaction.

• Technical Support: (+1) 613-652-4886
• After Hours Emergency: (+1) 613-349-0006
• E-mail: techsupport@rossvideo.com 
• Website: http://www.rossvideo.com 

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Before You Begin
If you have questions pertaining to the operation of the Streaming Gateway, contact us at the 
numbers listed in “Contacting Ross Video Technical Support”. 

Overview
The softGear Streaming Gateway is a transport converter with built-in micro-services. The 
Streaming Gateway allows you to transport content between on-premise and the cloud, in both 
directions. Multiple simultaneous streams of the same or different type are supported. It is based 
on softGear™ micro-service architecture, and can run on a Dell® server or an AWS EC2 instance. In 
addition, WebRTC has a mechanism which allows for easy to use remote contribution from any 
browser. 

Figure 1 provides a general functional block diagram of the Streaming Gateway where an SDI video 
signal (with embedded PCM audio) is received by an SDI port and is converted to an H264 WebRTC 
output.

Figure 1  Functional Block Diagram — SDI Input to WebRTC Output

Figure 2 provides a general functional block diagram of the Streaming Gateway where an H264 
WebRTC stream is the source and is decoded to an SDI video signal (with embedded PCM audio) for 
an SDI output. 

Figure 2  Functional Block Diagram — WebRTC Input to an SDI Output
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Figure 3 provides a general functional block diagram of the Streaming Gateway where an SDI video 
signal (with embedded PCM audio) is received by an SDI port and is converted to an H264 SRT 
output.

Figure 3  Functional Block Diagram — SDI Input to SRT Output

Figure 4 provides a general functional block diagram of the Streaming Gateway where an H264 SRT 
stream is the source and is decoded to an SDI video signal (with embedded PCM audio) for an SDI 
output. 

Figure 4  Functional Block Diagram — SRT Input to an SDI Output

Figure 5 provides a general functional block diagram of the Streaming Gateway where an NDI 
stream is the source and is converted to an H264 SRT output.

Figure 5  Functional Block Diagram — NDI Input to SRT Output
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Figure 6 provides a general functional block diagram of the Streaming Gateway where an H264 SRT 
stream is the source and is decoded to an NDI stream for an NDI output. 

Figure 6  Functional Block Diagram — SRT Input to an NDI Output

Figure 7 provides a general functional block diagram of the Streaming Gateway where an SDI video 
signal (with embedded PCM audio) is received by an SDI port and is sent to an NDI output.

Figure 7  Functional Block Diagram — SDI Input to NDI Output

Figure 8 provides a general functional block diagram of the Streaming Gateway where an NDI 
stream is the source and is sent to an SDI video signal (with embedded PCM audio) for an SDI 
output. 

Figure 8  Functional Block Diagram — NDI Input to an SDI Output
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Features
The Streaming Gateway includes the following features:

• Support for MPEG2-TS over SRT transmission and reception
• Support for streams from Microsoft Teams and Zoom Rooms
• Supports multiple resolutions and frame rates. Refer to “Connections” for details.
• 8 SDI DIN ports, with 4 pre-defined as inputs, 4 pre-defined as outputs (with embedded audio), 

and 1REF IN port
• One gigabit Ethernet connection for facility network and data transmission over public networks
• WebRTC transmission and reception
• NDI transmission and reception
• CDI transmission and reception (on AWS cloud)
• Intuitive control and monitoring via DashBoard

DashBoard Interfaces
The Streaming Gateway requires an Ethernet network connection between it and a computer that 
will run the DashBoard client. The DashBoard client software enables you to monitor and control 
DashBoard Connect compatible devices from a computer. 

The Streaming Gateway includes DashBoard interfaces for configuration and operation. The 
interfaces are accessed by expanding the Streaming Gateway node in the DashBoard Tree View and 
selecting the appropriate sub-node. 

For More Information on...
• displaying the DashBoard interfaces, refer to “Using DashBoard”.

Installation Overview
The user needs to ensure the following tasks are performed for on-premise servers:

1. Physically install the Streaming Gateway in a rack frame. Refer to the Streaming Gateway Quick 
Start Guide. 

2. Cable the Ethernet connection on the back panel. Refer to “Connecting to a Network”.

3. Cable the video I/O. Refer to “Cabling”.

4. Connect the two power ports on the back panel. Refer to “Connecting the Power Supplies”.

For More Information on...
• installing the Streaming Gateway in the cloud, refer to the Streaming Gateway Cloud Installation 

Guide.

Configuration Overview
Figure 9 provides a generalized work-flow of configuring your Streaming Gateway.

Figure 9  Configuration Work-flow
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Assign the Network Settings
The user connects the Streaming Gateway to the network and ensures it can communicate with a 
computer running the latest DashBoard client software. The DashBoard client software enables you 
to monitor, configure, and operate your Streaming Gateway.

For More Information on...
• configuring the initial network settings, refer to “Initial Connection”.
• displaying the Streaming Gateway in DashBoard, refer to “Using DashBoard”. 
• the menus and parameters available in DashBoard, refer to “DashBoard Interface Overview”.

Connect to an NTP Server
Once the user can successfully access the Streaming Gateway in DashBoard, the next step is to 
establish a connection to an NTP Server. The Streaming Gateway requires an accurate time 
reference, in order to ensure correct watermarking and crediting. Refer to “Configuring the NTP 
Settings”.

Configure the Connections
Configure the network streams (connection points) for the Streaming Gateway by mapping the 
inputs to the available outputs. Refer to “Connections”.
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Integration Examples
This chapter provides a few integration examples, though your needs may differ from what is 
presented here.

WebRTC Input to Multiple SDI Outputs
Figure 10 illustrates a workflow where the Streaming Gateway assigns a single WebRTC input 
stream to multiple SDI outputs.

Figure 10  Workflow — One WebRTC Stream to Multiple SDI Outputs

This setup requires you to:

1. Cable four SDI ports on the back panel as outputs. Refer to “SDI Cabling”.

2. Configure a connection with an:

a. input from a WebRTC peer. Refer to “To specify a WebRTC stream as a source”.

b. output to an SDI port. Refer to “To assign an SDI output as the destination”.

3. Repeat step 2 for the remaining three SDI outputs.
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SDI Input to Multiple WebRTC Outputs
Figure 11 illustrates a workflow where the Streaming Gateway assigns a single SDI input to multiple 
WebRTC outputs (one with video, and three with audio).

Figure 11  Workflow — One SDI Input to Multiple WebRTC Streams

This setup would require you to:

1. Cable one SDI port on the back panel as an input. Refer to “SDI Cabling”.

2. Configure a connection with an:

a. input to an SDI port. Refer to “To specify the SDI input as a source”.

b. output to a WebRTC peer. Refer to “To assign a WebRTC stream as the destination”.

3. Repeat step 2 for the remaining three WebRTC outputs.

Only one SDI to WebRTC connection with video is permitted. The remaining connections must be 
audio only.
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Multiple On-Premise Inputs to Multiple Cloud Outputs
Figure 12 illustrates a workflow where the Streaming Gateway assigns an on-premise SDI input and 
an on-premise NDI input to cloud outputs via SRT.

Figure 12  Workflow — On-Premise SDI and NDI Inputs to Cloud Outputs via SRT

This setup would require you to:

1. Cable one SDI port on the back panel as an input. Refer to “SDI Cabling”.

2. Configure a connection on-premise with an:

a. input to an SDI port. Refer to “To specify the SDI input as a source”.

b. output to an SRT peer. Refer to “To assign an SRT stream as the destination”.

3. Configure a connection in the cloud with an:

a. input to an SRT peer. Refer to “To specify an SRT stream as a source”.

b. output to an NDI or CDI peer. Refer to “To assign an NDI stream as the destination” or “To 
assign a CDI stream as the destination”.
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Multiple Cloud Inputs to Multiple On-Premise Outputs
Figure 13 illustrates a workflow where the Streaming Gateway assigns two cloud NDI or CDI inputs 
to on-premise SDI outputs via SRT.

Figure 13  Workflow — NDI or CDI Cloud Inputs to On-Premise SDI Outputs via SRT

This setup would require you to:

1. Cable two SDI ports on the back panel as outputs. Refer to “SDI Cabling”.

2. Configure a connection in the cloud with an:

a. input to an NDI or CDI peer. Refer to “To specify the NDI stream as a source” or “To 
specify the CDI stream as a source”.

b. output to an SRT peer. Refer to “To assign an SRT stream as the destination”.

3. Configure a connection on-premise with an:

a. input to an SRT peer. Refer to “To specify an SRT stream as a source”.

b. output to an SDI port. Refer to “To assign an SDI output as the destination”.

4. Repeat steps 2 and 3 for the remaining SDI output.
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Multiple Teams NDI Inputs to Multiple SDI Outputs
Figure 14 illustrates a workflow where the Streaming Gateway assigns four Teams NDI inputs to 
four SDI outputs.

Figure 14  Workflow — Teams NDI Inputs to SDI Outputs

This setup would require you to:

1. Cable one SDI port on the back panel as an input. Refer to “SDI Cabling”.

2. Configure a connection with an:

a. input to an NDI peer. Refer to “To specify the NDI stream as a source”.

b. output to an SDI port. Refer to “To assign an SDI output as the destination”.

3. Repeat step 2 for the remaining three SDI outputs.

4. Configure a connection with an:

a. input to an SDI port. Refer to “To specify the SDI input as a source”.

b. output to an NDI peer. Refer to “To assign an NDI stream as the destination”.

For information on how to configure Teams to enable NDI output and input streams, visit 
https://support.microsoft.com/en-us/office/broadcasting-audio-and-video-from-teams-with-ndi-an
d-sdi-technology-e91a0adb-96b9-4dca-a2cd-07181276afa3
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Multiple Zoom Rooms NDI Inputs to Multiple SDI Outputs
Figure 15 illustrates a workflow where the Streaming Gateway assigns three Zoom Rooms NDI 
inputs to three SDI outputs.

Figure 15  Workflow — Zoom Rooms NDI Inputs to SDI Outputs

This setup would require you to:

1. Cable one SDI port on the back panel as an input. Refer to “SDI Cabling”.

2. Configure a connection with an:

a. input to an NDI peer. Refer to “To specify the NDI stream as a source”.

b. output to an SDI port. Refer to “To assign an SDI output as the destination”.

3. Repeat step 2 for the remaining three SDI outputs.

4. Configure a connection with an:

a. input to an SDI port. Refer to “To specify the SDI input as a source”.

b. output to an NDI peer. Refer to “To assign an NDI stream as the destination”.

For information on how to configure Zoom Rooms to enable NDI output and input streams, visit 
https://support.zoom.us/hc/en-us/articles/360061903532-Using-Network-Device-Interface-NDI-
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Hardware Overview
This chapter presents information on the Streaming Gateway hardware. Note that for cloud 
instances, Amazon EC2 is used instead of the Dell® hardware.

Front Panel Overview
This section provides a general overview of the features of the Streaming Gateway front panel.

Figure 16  Streaming Gateway — Front Panel (Door Removed)

POWER Button

This is the main power button for the Streaming Gateway.

Back Panel Overview
This section provides an overview of the features of the Streaming Gateway back panel.

Figure 17  Streaming Gateway — Back Panel

1. SDI Ports

This area includes the DIN ports that are predefined as an SDI input or SDI outputs. Refer to 
Figure 17 for cabling designations.

2. REF IN Port

This port connects to an independent analog video reference source.

3. 1G Ethernet Port

This standard 10/100/1000 Base-TX RJ45 connector is used to connect the Streaming Gateway to 
your primary facility network. This is required to bridge the external Ethernet network to the local 
communication bus for monitoring and controlling the Streaming Gateway using DashBoard.

4. 10G Ethernet Port

This port is not implemented. 

5, 6 Power Supplies

The Streaming Gateway comes standard with two power supplies. 

POWER Button

5 63

421
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Physical Installation
This chapter provides additional information needed for installing the Streaming Gateway and 
DashBoard before you can proceed to cabling and configuring your Streaming Gateway. Note that 
for cloud instances, Amazon EC2 is used instead of the Dell® hardware, meaning there is no 
physical installation.

Installing the Streaming Gateway in a Rack Frame
Refer to the Streaming Gateway Quick Start Guide that accompanied your device and its mounting 
kit for installation information.

Connecting to a Network
The Streaming Gateway is connected to your network via the 1G port on the back panel. The 1G 
port enables the Streaming Gateway to interface with other devices in your facility (such as an NTP 
server), and the computer running the DashBoard client. 

Before You Begin
Contact your IT department before connecting to a network to ensure that there are no conflicts. 
They will provide you with an appropriate value for the IP Address, Subnet Mask, and Gateway for 
your Streaming Gateway.

 If difficulties or problems are experienced when connecting the Streaming Gateway to a network 
hub, contact your network administrator.

For More Information on...
• downloading and installing DashBoard, refer to the DashBoard User Manual.

Connecting to your Facility Network

 Ensure that the Streaming Gateway is on the same network as your DashBoard client computer.

To connect the Streaming Gateway to your facility network

1. Connect one end of a standard RJ45 cable to the 1G port on the Streaming Gateway back panel.

2. Connect the other end of the same RJ45 cable to your Local Area Network (LAN).

To facility network
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Connecting the Power Supplies
For redundancy, each power cord should be connected to a separate power source for protection 
against failure of the A/C power circuit. In the event of one power supply failure, the frame load is 
transferred to the other redundant power supply. 

The power supply plugs into the right-hand section of the Streaming Gateway back panel. The 
universal power supply supports all worldwide AC power voltages, and no power adjustments are 
required. 

To connect the Streaming Gateway to the power supplies

1. Connect the cable’s female IEC connector to the right power socket.

2. Plug the second IEC connector into left power socket.

3. Connect each supplied power cable’s three-prong male connector to an AC outlet.

4. Power on the Streaming Gateway by pressing the POWER button on the front panel. Refer to 
“Front Panel Overview” for the location of this button.

 The fans run at full speed for a short period at the startup.

Warning — In some countries, it may be necessary to supply the correct mains supply cord. Use only 
an approved IEC 320 C-13 type A/C line cord rated for a minimum 10A at 250V and certified for the 
country of use.

Warning Hazardous Voltages — The safe operation of this product requires that a protective 
earth connection be provided. This protective earth is provided by the grounding conductor in the 
equipment’s supply cord. To reduce the risk of electrical shock to operator and service personnel, this 
ground conductor must be connected to an earthed ground.

To Power Source 2 To Power Source 1
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Cabling
If you have questions pertaining to the installation of the Streaming Gateway, contact us at the 
numbers listed in “Contacting Ross Video Technical Support”. Our technical staff is always 
available for consultation, training, or service.

Connecting a Reference Source to the Streaming Gateway
The Streaming Gateway back panel also includes a REF IN DIN port that can connect to a CVBS BLS 
or TLS reference source.

 Ross Video provides a DIN-to-BNC Adapter Cable for this connection.

To connect a reference source to the Streaming Gateway

1. Connect one end of the provided cable to the REF IN port on the Streaming Gateway.

2. Connect the other end of the same cable to the applicable output port on the external 
reference source device.

SDI Cabling
The Streaming Gateway provides DIN ports that can be connected to SDI sources or downstream 
devices. 

 Ross Video provides DIN-to-BNC Adapter Cables for these connections.

To cable your SDI signals

1. Connect your SDI source device to the DIN port as indicated below.
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2. Connect your downstream SDI devices to the DIN ports as indicated below.
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Initial Connection
The Streaming Gateway is configured and operated via its interfaces in DashBoard. Once the 
Streaming Gateway is physically installed and connected to your facility network, you must 
manually add the Streaming Gateway to the Tree View in DashBoard. The Tree View lists all 
DashBoard Connect devices that the DashBoard client can communicate with. Once you add the 
Streaming Gateway to the Tree View, you can access its interfaces.

 If you have questions pertaining to the operation of Streaming Gateway, contact us at the 
numbers listed in “Contacting Ross Video Technical Support”. Our technical staff is always 
available for consultation, training, or service.

Physical Connections to the Streaming Gateway
Before proceeding, ensure that the Streaming Gateway is:

• connected to your network. Refer to “Connecting to a Network”.
• powered on. Refer to “Connecting the Power Supplies”.

Launching DashBoard
The DashBoard client software must run on a computer that has a physical wired Ethernet 
connection. Wireless connections do not allow device discovery.

To launch DashBoard

1. Ensure that you are running DashBoard software version 9.6 or higher.

2. Ensure the DashBoard client computer has an IP address of 192.168.x.x. This will allow it to 
communicate with the Streaming Gateway.

3. Launch DashBoard by double-clicking its icon on your computer desktop.

Manually Adding the Streaming Gateway to the Tree View
The Streaming Gateway does not automatically display in the DashBoard Tree View. You must 
manually add it to the Tree View.

To manually add the Streaming Gateway to the Tree View in DashBoard

1. From the main toolbar in DashBoard, select File > New > TCP/IP DashBoard Connect or 
openGear Device.

The New TCP openGear Frame Connection dialog opens.

2. In the IP Address field, enter the default IP address of 192.168.0.100.

3. Click Detect Frame Information.

 If you wish to assign a unique name for the Streaming Gateway, enter it in the Display Name 
field.

4. Click Finish to close the dialog.

5. Verify that the softGear Streaming Gateway node displays in the DashBoard Tree View, along 
with the System sub-node below it.

6. Continue to “Licensed Features” to license your server.
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Licensed Features
The Streaming Gateway has software licenses for enabling functions and features. To access the 
SSG sub-node where you can make use of these functions and features, it is required that you first 
license your server. This chapter outlines the available software licensed features, and how to 
install a product key for a licensed feature. 

Licensing Overview
There are two kinds of licensing supported: node locked (for on-premise servers) and floating (for 
cloud servers).

The licensing component provides an alarm (shown in DashBoard) which indicates the current state 
of licensing, along with the status field on the System > Licensing tab. These fields will always be 
populated for a licensed system and warn the users of any changes or issues, such as licenses 
expiring soon (within a week), or in the case of floating licensing, if the connection between the 
Streaming Gateway and the Ross Platform Manager (RPM) has been lost.

 Expired or invalid licenses will result in the immediate termination of all features.

Floating Licensing
Floating licensing is integrated with the RPM, and requires a constant connection with the RPM.

The Streaming Gateway re-activates licenses on a regular interval with the RPM. If an activation fails 
as a result of being unable to reach the RPM, the Streaming Gateway will start a 2-day grace period 
before terminating the features. During this time, the Streaming Gateway will operate as normal. A 
reboot will remove any Streaming Gateway grace period in effect and the Streaming Gateway will 
start without any features. If an activation fails as a result of the RPM being unable to reach the 
activation server, the RPM will start a grace period where the Streaming Gateway will be able to 
continue activating the licenses without issues. After the RPM's grace period is over, the features 
will be terminated. The Streaming Gateway can be rebooted safely while the RPM grace period is in 
effect. See the RPM documentation for more information.

When the Streaming Gateway is rebooted or turned off, it will deactivate all of its licenses with the 
RPM.

Product Keys Overview
Table 1 provides a brief summary on the types of licensed features available for the Streaming 
Gateway.

Table 1  List of Streaming Gateway Licensed Features

License Description
Platform Basic license for the softGear product line

NDI Receiver Enables the Streaming Gateway to receive network streams via 
the NDI protocol 

NDI Sender Enables the Streaming Gateway to transmit network streams via 
the NDI protocol

WebRTC Transceiver Enables the Streaming Gateway to transmit and receive network 
streams via the WebRTC protocol
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Installing a Product Key
Ross Video uses product keys to control user access to specific Streaming Gateway features. You 
can obtain a key for a Streaming Gateway licensed feature from Ross Video Technical Support.

To install a Streaming Gateway Product Key

1. In the Basic Tree View of DashBoard, locate the softGear Streaming Gateway node.

2. Expand the softGear Streaming Gateway node.

3. Double-click the System sub-node.

4. Select the Licensing tab.

5. Enter the Product Key in the Product Key field.

6. Click Activate.

7. Verify that the Status field updates to Activation Successful and the Licensing Table populates.

8. Click Factory Default.

 Factory Default will reset ALL configuration settings.

The SSG sub-node will now be available in the Basic Tree View of DashBoard under the 
softGear Streaming Gateway node.

9. Continue to “Updating the Network Settings” to assign new static network settings as 
determined by your IT Department.

BlackMagic SDI Global For BNC configurations (SDI Input and Output ports) (for 
on-premise servers only)

BlackMagic SDI Input Enables the SDI ports on the back panel to be configured and 
used as SDI inputs (for on-premise servers only)

BlackMagic SDI Output Enables the SDI ports on the back panel to be configured and 
used as SDI outputs (for on-premise servers only)

CDI Receiver Enables the Streaming Gateway to receive network streams via 
the CDI protocol (for AWS cloud only)

CDI Sender Enables the Streaming Gateway to transmit network streams via 
the CDI protocol (for AWS cloud only)

Uhura Centralized UI 
Controller

For communication between MPUs and DashBoard UI, and 
handling connection management

SRT Transceiver Enables the Streaming Gateway to transmit and receive MPEG-TS 
streams via SRT protocol

SDI-NDI Conversion Enables the Streaming Gateway to convert between SDI and NDI

MPEG2-TS Muxer Enables the Streaming Gateway to encode video and audio and 
multiplex them to the MPEG2-TS stream

MPEG2-TS Demuxer Enables the Streaming Gateway to demultiplex the MPEG2-TS 
stream and decode video and audio

Video Scaler Enables the Streaming Gateway to change the video resolution 
and frame rate

Audio Sample Rate 
Converter

Enables the Streaming Gateway to change the audio sample rate

Table 1  List of Streaming Gateway Licensed Features

License Description
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Uninstalling a Product Key
Whether your use of Streaming Gateway features has changed, or you are switching to using 
another device, you will need to uninstall the product key that you were using.

To uninstall a Streaming Gateway Product Key

1. In the Basic Tree View of DashBoard, locate the softGear Streaming Gateway node.

2. Expand the softGear Streaming Gateway node.

3. Double-click the System sub-node.

4. Select the Licensing tab.

5. Click Deactivate.

6. Click Yes when prompted.

The Product Key has been uninstalled.

7. Click Factory Default.

 A Factory Default will reset ALL configuration settings. 
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Updating the Network Settings
Once the Streaming Gateway is communicating via DashBoard, it is recommended to assign a 
different static IP address from the factory default values. These default values are used to initially 
establish a connection point to the Streaming Gateway, as outlined in your Streaming Gateway 
Quick Start Guide. 

This chapter provides instructions to change the default network settings for the Streaming 
Gateway to communicate with your facility network and streaming devices.

 Contact your IT Department for more information on changing these settings.

Updating the Network Settings
The 1G port enables the Streaming Gateway to interface with other devices in your facility, and the 
computer running the DashBoard client. Once the Streaming Gateway is communicating via 
DashBoard using the default values, it is recommended to assign a different static IP address from 
the default to one that adheres to your IT requirements.

To update the network settings for the Streaming Gateway

1. Display the System sub-node as outlined in “To display the System sub-node in DashBoard”.

2. Ensure the Ethernet tab is selected.

3. Use the IPv4 Address field to specify the new static IP address for the 1G port.

4. Use the Subnet Mask field to specify the subnet mask for the 1G port. 

5. Use the Gateway field to specify the gateway for communications outside of the local area 
network (LAN) the Streaming Gateway will use.

6. Use the DNS field to specify the IP address of the DNS server that the Streaming Gateway will 
communicate with.

7. Click Apply.

The Streaming Gateway automatically reboots and applies the changes.

 If a DHCP address is preferred, set the Method menu to DHCP, and ensure that all IP settings are 
retrieved successfully from the DNS server.

Configuring the NTP Settings
You have the option to set the current date and time on the system clocks of the Streaming 
Gateway by using a Network Time Protocol (NTP) server. This requires you to enter the IP address of 
up to two (2) NTP servers. The Streaming Gateway must be able to access these IP addresses to 
acquire the time from an NTP server.

To set the system time of the Streaming Gateway

1. Display the System sub-node as outlined in “To display the System sub-node in DashBoard”.

2. Select the Timing tab. 

3. In the NTP Server 1 field, enter the IP address of the first NTP server you want to add.

4. If required, in the NTP Server 2 field, enter the IP address of the second NTP server you want to 
add.

5. Click Apply Changes.
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6. Wait until the Streaming Gateway is synchronized to the new NTP server and OK displays in the 
NTP Status field. 

7. If OK is not displayed, check: 

• that the time displayed in the Current Time field is correct;
• that the IP address is correct;
• that the Streaming Gateway has access to the address.
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Using DashBoard
The Streaming Gateway interfaces and settings are accessed by expanding the main softGear 
Streaming Gateway node in the Basic Tree View, and then selecting the appropriate sub-node. The 
System sub-node provides settings for setting up the Streaming Gateway. The SSG sub-node 
provides interfaces for configuring and monitoring the Streaming Gateway. This chapter provides 
instructions for accessing both sub-nodes of the Streaming Gateway and their contents in 
DashBoard.

Accessing the System Sub-node in DashBoard
The System sub-node in Dashboard is organized into a series of tabs. The main top toolbar displays 
the Ethernet, Licensing, Timing, Features, and About tabs.

To display the System sub-node in DashBoard

1. In the Basic Tree View of DashBoard, locate the softGear Streaming Gateway node.

2. Expand the softGear Streaming Gateway node.

3. Double-click the System sub-node.

The Ethernet tab is automatically selected.

The Ethernet tab provides options and information to configure the network settings for the 
1G port on the back panel.
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4. Select the Licensing tab.

The Licensing tab allows you to license your server, and provides options to manage the 
features that require a valid Product Key.

5. Select the Timing tab.

The Timing tab provides information regarding NTP timing.



Streaming Gateway User Guide (v8.0) Using DashBoard • 41

6. Select the Features tab.

The Features tab provides information on all of the running features.

7. Select the About tab.

The About tab provides general system information, such as the serial number and product 
version, and also allows you to download an archive of the logs.

Accessing the SSG Sub-node in DashBoard
The SSG sub-node in DashBoard is organized into a series of tabs and sub-tabs. The main top 
toolbar displays the Connections Control, Source Configuration, Destination Configuration, 
and Configuration tabs. When the Configuration tab is selected, additional sub-tabs are displayed 
on a toolbar located at the bottom of the interface.

To display the SSG sub-node in DashBoard

1. In the Basic Tree View of DashBoard, locate the softGear Streaming Gateway node.

2. Expand the softGear Streaming Gateway node.
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3. Double-click the SSG sub-node.

The Connections Control tab is automatically selected.

The Connections Control tab enables you to specify which connections are active (online) or 
not (offline), and monitor the connection points of the Streaming Gateway. 

4. Select the Source Configuration tab.

The Source Configuration tab enables you to manage the input signals that the Streaming 
Gateway will have access to. The tab is organized into two panes. The left pane lists all the 
configured sources in a table format. Selecting a row in this table displays the options for the 
selected source in the right pane of the window.

5. Select the Destination Configuration tab.

The Destination Configuration tab enables you to manage the output signals that the 
Streaming Gateway will have access to. The tab is organized into two panes. The left pane lists 
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all the configured destinations in a table format. Selecting a row in this table displays the 
options for the selected destination in the right pane of the window.

6. Select the Configuration tab.

From this tab you can access the Global Settings, API Control, Preset Connections, and About 
sub-tabs (located in the bottom toolbar). By default, the Global Settings sub-tab is automatically 
selected. Refer to “Configuration Interface” for a detailed explanation of the options 
contained within each sub-tab.
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Connections
This chapter outlines how to configure the sources (inputs) and then assign them to destinations 
(outputs) to create connections for your Streaming Gateway. The source types displayed will 
depend on the license used for your server. Once all connections are assigned, you can then enable 
each connection as required.

Overview
A connection is created by mapping a source to a destination. The Streaming Gateway supports 
multiple audio/video transport protocols:

• NDI
• SRT
• WebRTC
• SDI (On-Premise)
• CDI (AWS Cloud)

Table 2 lists the Streaming Gateway input and output protocols. 

Note: The following conditions apply to SDI and CDI sources.

• SDI sources are on-premise only.
• CDI sources are AWS cloud only.

Audio/video signal conversions are also supported by the Streaming Gateway as required.

Configuring the Source for a Connection
Each connection is configured independently, allowing you to assign different types of sources as 
the source for a connection. This section outlines how to assign the SDI input signal, or the NDI, CDI, 
SRT, or WebRTC stream as a source. Once all the sources are configured, you can proceed to assign 
each source to an output (destination) to create a connection.

 By default, there are two sources populated in DashBoard. You may edit one of these preexisting 
sources instead of creating a new one, if desired.

Specifying the SDI Input as a Source
Ensure that you have connected the SDI source to Port 1 on the Streaming Gateway. Refer to “SDI 
Cabling” for details.

Table 2  Supported Protocols

Input/Output SDI/CDI NDI SRT WebRTC
SDI/CDI Yes Yes Yes Yes

NDI Yes Yes Yes Yes

SRT Yes Yes Yes No

WebRTC Yes Yes No No
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To specify the SDI input as a source

1. Display the Source Configuration interface as outlined in “Accessing the SSG Sub-node in 
DashBoard”. 

2. Click Create Source.

A new row displays in the source table (left pane) and the DashBoard window updates to 
display the Source Configuration options (right pane).

3. Use the Name field to specify a unique identifier for the source.

The source name is used to identify the available sources on the Destination Configuration 
tab.

4. Use the Type menu to select SDI.

The Source Configuration area updates to display options for configuring the source as an SDI 
input signal.
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5. Use the Port menu to specify the physical SDI port on the back panel that will be the input 
signal for this source.

 The Video Format field reports the signal format on the selected Port. This field is read-only.

6. Click Apply.

7. Continue to “Configuring the Destination for a Connection”.

Specifying the NDI Stream as a Source
The Global Settings sub-tab (located in the SSG > Configuration tab) provides options for NDI Global 
Source Discovery. 

 If you are using a private group or an external server, ensure that the NDI Global Source 
Discovery is set accordingly. Refer to “Global Settings Tab” for a list of options.

To specify the NDI stream as a source

1. Display the Source Configuration interface as outlined in “Accessing the SSG Sub-node in 
DashBoard”. 

2. Click Create Source.

A new row displays in the source table (left pane) and the DashBoard window updates to 
display the Source Configuration options (right pane).

3. Use the Name field to specify a unique identifier for the source.

The source name is used to identify the available sources on the Destination Configuration tab.

4. Use the Type menu to select NDI.

The Source Configuration area updates to display options for configuring the source as an NDI 
stream.
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5. Click the Update button beside the NDI Source menu. 

6. Use the NDI Source menu to select the desired source.

The IP Address field populates with the IP Address for the selected source.

 If you want to create an NDI source instead of selecting an existing one, select the Create NDI 
Source box and manually fill the IP Address and Port fields.

7. Click Apply.

8. Continue to “Configuring the Destination for a Connection”.

Troubleshooting Tip
When the setup forms a loop where NDI is a sender, this can lead to an issue when rebooting or 
switching the connection offline then online. An example of the setup would be:

On-Premise Server: SDI --> SRT (caller)
Cloud Instance 1: SRT (listener) --> NDI (sender)
Cloud Instance 2: NDI (receiver) --> SRT (listener)
On-Premise Server: SRT (caller) --> SDI

After a reboot or being switched offline then online, the NDI receiver on Cloud Instance 2 in this 
example will report no signal because the designated port has changed. There are two methods to 
fix this:

Method 1

1. Turn off Cloud Instance 2.

2. Change the Port to the next Port in the range of 5961-6061 until the NDI receiver detects the 
signal and the status reports it.

Method 2

1. Turn the connection offline.

2. On the Source Configuration tab, clear the Create NDI Source box. 

3. Click the Update button beside the NDI Source menu.

4. Use the NDI Source menu to select the desired source.

5. Select the Create NDI Source box.
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6. Click Apply.

7. Turn the connection back online. 

 The NDI External IP field on the Configuration tab must contain the IP address of the NDI 
Sender for this to work. For more information on the NDI External IP field, refer to Table 28.

Specifying the CDI Stream as a Source
CDI is only used in the AWS cloud. Make sure that you are using an instance with EFA and that the 
driver has been installed.

To specify the CDI stream as a source

1. Display the Source Configuration interface as outlined in “Accessing the SSG Sub-node in 
DashBoard”. 

2. Click Create Source.

A new row displays in the source table (left pane) and the DashBoard window updates to 
display the Source Configuration options (right pane).

3. Use the Name field to specify a unique identifier for the source.

The source name is used to identify the available sources on the Destination Configuration tab.

4. Use the Type menu to select CDI.

The Source Configuration area updates to display options for configuring the source as a CDI 
stream.

5. Use the Port menu to specify the port for the input signal of this source.

The Video Format field reports the signal format on the selected Port. This field is read-only.

6. Click Apply.

7. Continue to “Configuring the Destination for a Connection”.

Specifying an SRT Stream as a Source
To establish an SRT-to-SRT connection, one of the peers must operate in Listener mode while the 
other operates as Caller. The mode of operation for the peer is determined by network 
configuration. It is not important which mode either the source or destination operates in. 
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Keep in mind that:

• The SRT peer operating in Listener mode must be reachable over UDP on the port specified in the 
Local Port field for listener mode. 

• The SRT peer operating in Caller mode simply calls the listener at the specified Target URL 
(Host:Port).

To specify an SRT stream as a source

1. Display the Source Configuration interface as outlined in “Accessing the SSG Sub-node in 
DashBoard”. 

2. Click Create Source.

A new row displays in the source table (left pane) and the DashBoard window updates to 
display the Source Configuration options (right pane).

3. Use the Name field to specify a unique identifier for the source.

The source name is used to identify the available sources on the Destination Configuration tab.

4. Use the Type menu to select SRT.

The Source Configuration area updates to display options for configuring the source as an SRT 
stream.
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5. Use the Mode menu to select either Caller or Listener.

6. Use the Latency (ms) field to define the minimum receiver buffering delay before delivering an 
SRT data packet from a receiving SRT socket to stream decoder.

7. If the Mode selected in step 5 was Caller, use the Target URL (Host:Port) fields to define the IP 
and the port.

If the Mode selected in step 5 was Listener, use the Local Port field to define the port.

8. (optional) For configurations in which the Listener expects a specific Stream ID to be present, set 
the Stream ID field on the Caller to define the Stream ID for the connection.

 If you are using encryption, continue to step 9. If you are not using encryption, continue to step 
12.

9. Select the Encryption box.

10. Use the Key Length menu to select the desired key length to encrypt the data.

11. Use the Passphrase field to specify a string between 10-80 characters long. The passphrase 
must match for both peers.

12. Click Apply.

13. Continue to “Configuring the Destination for a Connection”.

Specifying a WebRTC Stream as a Source
You must manually specify the WebRTC credentials for each stream you wish to use as a source. 
Note that WebRTC does not support frame rate conversion. Any connection with a WebRTC source 
will not have Audio Sample Rate Converter (SRC) or Video Scaler options.

To specify a WebRTC stream as a source

1. Display the Source Configuration interface as outlined in “Accessing the SSG Sub-node in 
DashBoard”. 

2. Click Create Source.

A new row displays in the source table (left pane) and the DashBoard window updates to 
display the Source Configuration options (right pane).
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3. Use the Name field to specify a unique identifier for the source.

4. Use the Type menu to select WebRTC.

The Source Configuration area updates to display options for configuring the source as a 
WebRTC stream.

5. Use the Stream Name field to specify the unique identifier that the WebRTC application uses 
for this connection.

6. Use the Video Format menu to specify the video format of the stream.

7. Use the Websocket URI field to specify the Uniform Resource Identifier (URI) when connecting 
the Streaming Gateway to the remote WebRTC peer.

8. If required, use the Websocket Token field to specify the unique identifier that the Streaming 
Gateway will use for this specific connection.

9. Select the Has Video box if the stream includes video data.

10. Select the Has Audio if the stream includes audio data.

11. Click Apply.

12. Continue to “Configuring the Destination for a Connection”.
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Configuring the Destination for a Connection
A destination for a connection can include only the video, only the audio, or both the audio and 
video from a single source. Each destination is configured independently.

Assigning an SDI Output as the Destination
Before proceeding, ensure that you have assigned at least one SDI port as an output on the 
Streaming Gateway.

 An interlaced video format (1080i) input does not function correctly with a progressive video 
format output.

To assign an SDI output as the destination

1. Display the Destination Configuration interface as outlined in “Accessing the SSG Sub-node 
in DashBoard”. 

2. Click Create Destination.

A new row displays in the destination table (left pane) and the DashBoard window updates to 
display the Destination Configuration options (right pane).

 By default, there are two destinations populated in DashBoard. You may edit one of these 
preexisting destinations instead of creating a new one, if desired.

3. Use the Name field to specify a unique identifier for the destination.

This name is used to quickly identify connections on the Connections Control tab.

4. Use the Type menu to select SDI.

The Destination Configuration pane updates to display options for configuring the 
destination as an SDI output signal.
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5. Use the Video Source menu to specify the source for the destination. 

6. Select the Configure button for the Output Video Settings.

The Output Video Settings window opens.

7. Select the Output Video box to output the video data in this destination.

When the Output Video box is selected, the Video Scaler box will display.

8. Select the Video Scaler box to apply video scaling to the output video.

When the Video Scaler box is selected, the Video Format menu will display.

9. Use the Video Format menu to specify the video format of the SDI signal.

10. Use the Aspect Ratio Control menu to set the aspect ratio to Letterbox/Pillarbox or Full Frame.

11. Select Exit to close the Output Video Settings window.

The Output Video Settings window closes.
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12. Use the Port menu to assign the physical SDI output port to the destination.

13. Select the Output Audio box to output the audio data in this destination. 

When the Output Audio box is selected, the Audio SRC box will display.

14. Select the Audio Sample Rate Converter box to convert the sample rate of the audio.

15. Click Apply.

16. If you selected the Output Audio box in step 13, proceed to “Mapping the Audio Channels for 
an SDI or NDI Output”.

Assigning an NDI Stream as the Destination
In the same way that an SDI output needs a cable connection to work, an NDI stream needs a 
network card and a network connection for use as the destination.

When switching a connection with an NDI stream online and offline on a cloud server, the Port 
will change.

To assign an NDI stream as the destination

1. Display the Destination Configuration interface as outlined in “Accessing the SSG Sub-node 
in DashBoard”. 

2. Click Create Destination.

A new row displays in the destination table (left pane) and the DashBoard window updates to 
display the Destination Configuration options (right pane).

 By default, there are two destinations populated in DashBoard. You may edit one of these 
preexisting destinations instead of creating a new one, if desired.

3. Use the Name field to specify a unique identifier for the destination.

This name is used to quickly identify connections on the Connections Control tab.

4. Use the Type menu to select NDI.

The Destination Configuration pane updates to display options for assigning an NDI stream to 
a destination.
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5. Use the Video Source menu to select the desired source.

6. Use the Stream Name field to assign a unique identifier to the NDI stream.

7. Use the Group Name field to specify a private group name for the Receiver to join to get the 
stream.

8. Select the Configure button for the Output Video Settings.

The Output Video Settings window opens.

9. Select the Output Video box to output the video data in this destination.

When the Output Video box is selected, the Deinterlace and Video Scaler boxes will display.

10. Select the Deinterlace box to enable de-interlacing using linear interpolation. This only displays 
when the Video Source is a WebRTC source.

11. Select the Video Scaler box to apply video scaling to the output video.

When the Video Scaler box is selected, the Output Resolution and Output Frame Rate 
menus will display.

12. Use the Resolution menu to specify the resolution of the NDI signal.

13. Use the Frame/Field Rate menu to specify the frame rate of the NDI signal.

14. Select the Interlaced box to output interlaced video. 

When this box is not selected, the output is progressive video. This option is only accessible for 
certain Resolution and Frame/Field Rate format combinations. Refer to Table 23 for these 
combinations.

15. Use the Aspect Ratio Control menu to set the aspect ratio to Letterbox/Pillarbox or Full Frame.

16. Select Exit to close the Output Video Settings window.

The Output Video Settings window closes.

17. Select the Output Audio box to output the audio data in this destination. 

When the Output Audio box is selected, the Audio Sample Rate Converter menu will display.

18. Use the Audio Sample Rate Converter menu to select the rate at which to convert the sample 
rate of the audio.

19. Click Apply.
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20. If you selected the Output Audio box in step 17, proceed to “Mapping the Audio Channels for 
an SDI or NDI Output”.

Assigning a CDI Stream as the Destination
CDI is only used in the AWS cloud. Make sure that you are using an instance with EFA and that the 
driver has been installed.

To assign a CDI stream as the destination

1. Display the Destination Configuration interface as outlined in “Accessing the SSG Sub-node 
in DashBoard”. 

2. Click Create Destination.

A new row displays in the destination table (left pane) and the DashBoard window updates to 
display the Destination Configuration options (right pane).

 By default, there are two destinations populated in DashBoard. You may edit one of these 
preexisting destinations instead of creating a new one, if desired.

3. Use the Name field to specify a unique identifier for the destination.

This name is used to quickly identify connections on the Connections Control tab.

4. Use the Type menu to select CDI.

The Destination Configuration pane updates to display options for assigning a CDI stream to 
a destination.

5. Use the Video Source menu to select the desired source.

6. Use the IP field to identify the IP address of the receiver.

7. Use the Port menu to assign the output port to the destination.

8. Select the Update button for the Output Video Settings.

The Output Video Settings window opens.

9. Select the Output Video box to output the video data in this destination.

The Bid-Depth menu and Video Scaler box display.

10. Use the Bit-Depth menu to select the desired bit-depth.

11. Select the Video Scaler box to apply video scaling to the output video.
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The Output Resolution and Output Frame Rate menus display.

12. Use the Resolution menu to specify the resolution of the CDI signal.

13. Use the Frame/Field Rate menu to specify the frame rate of the CDI signal.

14. Select the Interlaced box to output interlaced video. 

When this box is not selected, the output is progressive video. This option is only accessible for 
certain Resolution and Frame/Field Rate format combinations. Refer to Table 24 for these 
combinations.

15. Select Exit.

The Output Video Settings window closes.

16. Select the Output Audio box to output the audio data in this destination. 

The Audio SRC menu displays.

17. Use the Audio SRC menu to select the rate at which to convert the sample rate of the audio. 

18. Select the Output ANC box to output the ancillary data in this destination.

19. Click Apply.

20. If you selected the Output Audio box in step 17, proceed to “Mapping the Audio Channels for 
a CDI Output”.

Assigning an SRT Stream as the Destination
To establish an SRT-to-SRT connection, one of the peers must operate in Listener mode while the 
other operates as Caller. The mode of operation for the peer is determined by network 
configuration. It is not important which mode either the source or destination operates in. Keep the 
following in mind:

• The SRT peer operating in Listener mode must be reachable over UDP on the port specified in 
the Local Port field for listener mode. 

• The SRT peer operating in Caller mode simply calls the listener at the specified Target URL 
(Host:Port). 

Refer to Table 25 for further information on the menus and fields involved in assigning an SRT 
stream as the destination.

To assign an SRT stream as the destination

1. Display the Destination Configuration interface as outlined in “Accessing the SSG Sub-node 
in DashBoard”.

2. Click Create Destination.

A new row displays in the destination table (left pane) and the DashBoard window updates to 
display the Destination Configuration options (right pane).
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 By default, there are two destinations populated in DashBoard. You may edit one of these 
preexisting destinations instead of creating a new one, if desired.

3. Use the Name field to specify a unique identifier for the destination.

This name is used to quickly identify connections on the Connections Control tab.

4. Use the Type menu to select SRT.

The Destination Configuration pane updates to display options for assigning an SRT stream to 
a destination.

5. Use the Mode menu to select either Caller or Listener.

6. Use the Bandwidth Mode options to specify the Bandwidth limits. Choose from the following:

• Hardware Limit — The Streaming Gateway applies the ethernet port bandwidth as the limit.
• Input Rate Limit — The Input Rate and Bandwidth Overhead fields are now editable.
• Manual Limit — The Bandwidth Limit field is now editable. 

7. If the Bandwidth Mode is set to Manual Limit, use the Bandwidth Limit (kbps) field to define 
the maximum sender bandwidth.
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8. If the Bandwidth Mode is set to Input Rate Limit:

a. Use the Bandwidth Overhead (%) field to define the recovery bandwidth overhead. 

b. Use the Input Rate (kbps) field to define the anticipated bitrate of your live stream.

9. Perform one of the following:

• If the Mode selected in step 5 was Caller, use the Target URL (Host:Port) fields to define the 
port.

• If the Mode selected in step 5 was Listener, use the Local Port field to define the port.

10. (optional) For configurations in which the Listener expects a specific Stream ID to be present, set 
the Stream ID field on the Caller to define the Stream ID for the connection.

11. Select the Video Stream Settings button for the Video Stream Settings.

The Video Stream Settings window opens.

12. Use the Video Source menu to select the desired source.

13. Use the PID Option menu to select Auto or Custom.

14. Use the PID Value menu to set a custom PID value if the PID Option is set to Custom.

15. Use the Encoding Profile menu to select the H264 profile to be used.

 If High 4:2:2 is enabled, Intel Quick Sync hardware acceleration will be disabled.

16. Use the Video BitRate(kbps) fields to define the video bitrate and mode. 

17. To apply video scaling to the output video:

a. Select the Video Scaler box.

The Output Resolution and Output Frame Rate menus display.

b. Use the Resolution menu to specify the resolution of the SRT signal.

c. Use the Frame/Field Rate menu to specify the frame rate of the SRT signal.

d. Select the Interlaced box to output interlaced video. 

When this box is not selected, the output is progressive video. This option is only accessible for 
certain Resolution and Frame/Field Rate format combinations. Refer to Table 25 for details.
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e. Use the Aspect Ratio Control menu to set the aspect ratio to Letterbox/Pillarbox or Full 
Frame.

18. Select OK.

The Video Stream Settings window closes.

 If you are using encryption, continue to step 19. If you are not using encryption, continue to step 
24.

19. Select the Configure button for Encrypt Stream.

The Encrypt Stream window opens.

20. Select the Encrypt box.

The Key Length menu and Passphrase field display.

21. Use the Key Length menu to select the desired key length to encrypt the data.

22. Use the Passphrase field to specify a string between 10-80 characters long. The passphrase 
must match for both peers.

23. Select Exit to close the Encrypt Stream window.

The Encrypt Stream window closes.

24. Select the Edit Audio Stream button for the Audio Stream Settings.

The Audio Stream Settings window opens.

25. Use the PID Option menu to select Auto or Custom.

26. Use the PID Value menu to set a custom PID value if the PID Option is set to Custom.

27. Use the AAC Encoder Bit Rate field to define the audio bitrate.

28. Use the Audio Sample Rate Converter menu to select the rate at which to convert the sample 
rate of the audio.

29. Select OK.

The Output Audio Settings window closes.

30. Click Apply.

31. Proceed to “Mapping the Audio Channels for an SRT Output”.

Assigning a WebRTC Stream as the Destination
You must manually specify the WebRTC credentials for each output stream you wish to use. 

WebRTC does not support frame rate conversion. Any connection with a WebRTC destination will 
not have Audio SRC or Video Scaler options.

To assign a WebRTC stream as the destination

1. Display the Destination Configuration interface as outlined in “Accessing the SSG Sub-node 
in DashBoard”. 

2. Click Create Destination.

A new row displays in the destination table (left pane) and the DashBoard window updates to 
display the Destination Configuration options (right pane).
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 By default, there are two destinations populated in DashBoard. You may edit one of these 
preexisting destinations instead of creating a new one, if desired.

3. Use the Name field to specify a unique identifier for the destination.

This name is used to quickly identify connections on the Connections Control tab.

 For WebRTC connections, some media servers do not recognize stream names with white space 
in them. Use single-string names only, with no spaces or special characters (hyphens and 
underscores are allowed).

4. Use the Type menu to select WebRTC.

The Destination Configuration pane updates to display options for assigning a WebRTC 
stream to a destination.

5. Use the Video Source menu to assign a source to the destination. 

6. Use the Stream Name field to assign a unique identifier to the WebRTC stream. This name is 
then entered in the WebRTC peer window to access the stream.
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 For WebRTC connections, some media servers do not recognize stream names with white space 
in them. Use single-string names only, with no spaces or special characters (hyphens and 
underscores are allowed).

7. Use the Websocket URI field to specify the Uniform Resource Identifier (URI) to use when 
connecting the Streaming Gateway to the remote WebRTC peer device.

8. If required, use the Websocket Token field to assign a unique identifier for this specific 
WebRTC connection.

9. Select the Configure button for the Output Video Settings.

The Output Video Settings window opens.

10. Select the Output Video box to include the video data from the source in this destination. 

The Quality menu and Drop Frames box display.

11. Use the Quality menu to select the output quality level.

12. Select the Drop Frames box to allow the Streaming Gateway to automatically drop frames 
when it detects a streaming bit rate higher than 2.5Mbps.

13. Select Exit.

The Output Video Settings window closes.

14. Select the Output Audio box to include the audio data from the source in this destination. 

 To configure an audio-only output, clear the Output Video box. To configure a video-only output, 
clear the Output Audio box.

15. Click Apply.

16. If you selected the Output Audio box in step 14, proceed to “Mapping the Audio Channels for 
a WebRTC Stream”.

Customizing the Audio Channel Mapping
This section outlines how to customize the audio channel mapping for a destination when the 
Output Audio box is selected for any output type.

Mapping the Audio Channels for an SDI or NDI Output
The number of audio channels you can map to the destination depends on the audio data from the 
assigned source.

To map the audio channels for an SDI or NDI output

1. Locate the Audio Channel Mapping area in the Destination Configuration tab.

2. Use the Output Channels slider to specify the number of channels to configure. 

 You can configure up to 16 output audio channels at once.

3. Select your Source using the drop down menu.

4. Click Apply Map.

 The output audio channels will automatically be configured with the selected source.

5. If needed, manually configure the output audio channels by using the Channel drop down 
menus to assign a source audio channel to a destination audio channel.

6. Click Apply.
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Mapping the Audio Channels for an SRT Output
The number of audio channels you can map to the destination depends on the audio data from the 
assigned source.

To map the audio channels for an SRT output

1. Locate the Edit Audio Stream button in the Destination Configuration tab.

2. Under Audio Stream Settings, locate the Audio Channel Mapping area.

3. Use the Output Channels slider to specify the number of channels to configure. 

 You can configure up to 16 output audio channels at once.

4. Select your Source using the drop down menu.

5. Click Apply Map.

 The output audio channels will automatically be configured with the selected source.

6. If needed, manually configure the output audio channels by using the Channel drop down 
menus to assign a source audio channel to a destination audio channel.

7. Click Apply.

Mapping the Audio Channels for a CDI Output
The number of audio channels you can map to the destination depends on the audio data from the 
assigned source.

To map the audio channels for a CDI output

1. Locate the Audio Channel Mapping area in the Destination Configuration tab.

2. Use the Output Channels slider to specify the number of channels to configure. 

 You can configure up to 16 output audio channels at once.

3. Select your Source using the drop down menu.

4. Click Apply Map.

 The output audio channels will automatically be configured with the selected source.

5. If needed, manually configure the output audio channels by using the Channel drop down 
menus to assign a source audio channel to a destination audio channel.

6. Click Apply.

Mapping the Audio Channels for a WebRTC Stream
The number of audio channels you can map to the destination depends on the audio data from the 
assigned source.

To map the audio channels for a WebRTC stream

1. Locate the Audio Channel Mapping area in the Destination Configuration tab.

2. Use the Output Channels slider to specify the number of channels to configure. 

 You can configure up to two output audio channels at once.

3. Select your Source using the drop down menu.

4. Click Apply Map.

 The output audio channels will automatically be configured with the selected source.
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5. If needed, manually configure the output audio channels by using the Channel drop down 
menus to assign a source audio channel to a destination audio channel.

6. Click Apply.

 The Streaming Gateway supports up to two audio channels in a WebRTC stream. These audio 
channels can then be mapped to any of the two output audio channels. Use either the first or 
second menu to enable (On) or disable (Off) the channel in the output path.

 Selecting Off will mute the channel in the output.

7. Click Apply.

Enabling a Connection
By default, a new connection is disabled (the status is reported as Offline) to ensure that a change in 
settings does not disrupt any downstream equipment or user portals. You must manually enable 
each connection by toggling its Online button on the Connections Control tab.

Enabling a Connection
Enabling a connection requires you to select it from the list of available connections and click the 
Online button. When the Online button is selected, the connection is published to downstream 
devices.

To enable a connection

1. Display the SSG sub-node in DashBoard as outlined in “Accessing the SSG Sub-node in 
DashBoard”.

2. Ensure the Connections Control tab is selected.

3. From the Connections table, select the row for the connection you wish to enable.

4. Click Online (located in the bottom left corner of the Connections table).

The Status fields for the source and destination update to report that the selected connection 
is now enabled.

Only one SDI to WebRTC connection with video is permitted. The remaining connections must be 
audio only.

Disabling a Connection
Clicking the Offline button for a connection immediately stops that session and freezes the output. 
This is helpful:

• to free up bandwidth
• if the source is invalid or missing
• if the source includes data that you do not want to output
• to update the connection settings

To disable a connection

1. Display the SSG sub-node in DashBoard as outlined in “Accessing the SSG Sub-node in 
DashBoard”.

2. Ensure the Connections Control tab is selected.

3. From the Connections table, select the row for the connection you wish to disable.

The Selected Connection area updates to display the settings for the connection.

4. Click Offline (located at the bottom of the Connections table).
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The Status fields for the source and destination update to report that the selected connection 
is now disabled.

Editing an Existing Connection
Before editing an existing connection, ensure that it is currently offline (disabled) and not in use by 
downstream equipment or user portals. A connection must be offline before it can be edited.

To edit an existing connection

1. Disable the connection as outlined in “Disabling a Connection”.

2. Edit the source for a connection using the steps in “Configuring the Source for a Connection”.

3. Edit the destination for a connection using the steps in “Configuring the Destination for a 
Connection”.

4. Enable the connection as outlined in “Enabling a Connection”.

 If you no longer want to save changes made to the connection, click Cancel instead of Apply. This 
will revert any changed field to its previous state.

Deleting a Connection
You cannot delete a connection that is currently online (active). You must first disable the 
connection, as outlined in “To disable a connection”, before proceeding to delete it.

To delete a connection

1. Disable the connection as outlined in “Disabling a Connection”.

2. Select the Destination Configuration tab.

3. From the Destinations table, select the row for the connection output you wish to delete. 

4. Click Delete Destination (located at the bottom of the Destinations table).

 If the Source for the deleted connection is no longer used by any other connection, it can also be 
deleted by performing steps 3-4 under the Source Configuration tab.

Troubleshooting
This section briefly summarizes some of the error messages that display on the Connections 
Control interface when creating the connections for your Streaming Gateway.

Audio Mapping is Invalid

The user attempted to map an unavailable (N/A) audio channel to a WebRTC stream. Ensure to map 
valid audio channels to your WebRTC stream as outlined in “Mapping the Audio Channels for a 
WebRTC Stream”.

Destination Does Not Have Output Video or Output Audio Enabled

The output video and audio sources are not detected for a Destination. Verify that the Output Video 
and/or Output Audio box is selected on the Destination Configuration interface for the Destination. 
Refer to “Configuring the Destination for a Connection”.
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Destination is Online

The user attempted to edit a Destination that was assigned to a connection that is currently online 
and in use. You must first disable the associated connection before editing the Destination. Refer to 
“Disabling a Connection” and “Editing an Existing Connection”.

Maximum of 16 WebRTC Streams is Supported

The Streaming Gateway supports a maximum of 16 active WebRTC stream connections. If you wish 
to add a new WebRTC connection, you will first need to delete or disable a connection. Refer to 
“Deleting a Connection” or “Disabling a Connection”.

Source is Online

The user attempted to edit a Source that was assigned to a connection that is currently online and 
in use. You must first disable the associated connection before editing the Source. Refer to 
“Disabling a Connection” and “Editing an Existing Connection”.

Video Source is Invalid

The user attempted to assign a video source that is not available (N/A). Refer to “Configuring the 
Source for a Connection” and “Configuring the Destination for a Connection”. 
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Upgrading the Software
The Streaming Gateway can be upgraded in the field via DashBoard.

 The Streaming Gateway is temporarily taken off-line during the upgrade process.

To upgrade the software on the Streaming Gateway

1. Contact Ross Technical Support for the latest software version file.

2. Ensure the Ethernet cable is connected to the 1G port on the Streaming Gateway.

3. Display the System sub-node as outlined in “To display the System sub-node in DashBoard”.

4. Select Upload, located near the bottom of the interface, to display the Select file Upload 
dialog. 

5. Navigate to the *.bin file you want to upload.

6. Click Open.

7. Click Next > to display the Select Destination menu. 

This menu provides a list of the compatible units.

8. Select the box for the Streaming Gateway you want to upload the file to.

The Error/Warning fields indicate any errors, such as incompatible software or product type 
mismatch.

9. Click Finish.

10. Monitor the upgrade.

An Upload Status dialog enables you to monitor the upgrade process.

11. Click OK.

• The Upload Status dialog closes.

 After the upgrade is complete, the server is automatically rebooted.

• The process is complete once the status indicators in the Connections Control tab return to 
their previous status.
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DashBoard Interface Overview
This chapter summarizes the sub-nodes, interfaces, tabs, and menus available from DashBoard for 
the Streaming Gateway.

System Sub-Node
The System sub-node has five main tabs with their own unique interfaces: the Ethernet, Licensing, 
Timing, Features, and About tabs.

Ethernet Tab
The Ethernet tab provides options to configure the network settings for the 1G port on the back 
panel. 

Figure 18  Example of the Ethernet tab

Table 3 summarizes the fields displayed in the Ethernet tab (Figure 18).

Table 3  System — Ethernet
Item Parameters Description

1-1G

Status (read-only) Reports the status of the connection: online (green), offline (gray), 
warning (yellow), or error (red)

MAC Address 
(read-only)

# Specifies the unique Media Access Control 
(MAC) Address assigned to the Streaming 
Gateway

IPv4 Address # Specifies the static IP Address that the user 
wants to manually assign to the specified 
Streaming Gateway port

Unknown The specified port is not configured
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Licensing Tab
Use the options on the Licensing tab to license your server, and to manage the features that require 
a valid Product Key.

Figure 19  Example of the Licensing tab

Subnet Mask # Specifies the subnet mask value for the 
specified port on the Streaming Gateway

Unknown The specified port is not configured

Gateway # Specifies the gateway for communications 
outside of the local area network (LAN) the 
specified port on the Streaming Gateway 
will use

Unknown The specified port is not configured

DNS # Specifies the IP address of the DNS server 
that the Streaming Gateway will 
communicate with

Methoda DHCP The settings will be assigned by a DHCP 
server in your facility

Manual The user manually supplies the settings

State (read-only) Activated The specified port is active and is 
communicating with valid settings

Disconnected Communication to the specified port is 
interrupted. Verify that the settings are 
correct and the port is physically cabled 
correctly.

Unavailable The specified port is not active and is not 
configured for use

Apply Click this button to apply the new settings to the 1G port

a. The options Unknown and Link-local are not implemented and should not be used.

Item Parameters Description
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Table 4 summarizes the options displayed in the Licensing tab (Figure 19).

Table 4  System — Licensing

Item Parameters Description
Product Key # Used to enter the Product Key in order to 

license the server

Activation Server <text> Used to enter the server the license must 
connect with to confirm its validity

Port # Used to select the Port for the Activation 
Server

Protocol HTTP Selects HTTP for the Activation Server

HTTPS Selects HTTPS for the Activation Server 

Activate Activates the entered Product Key

Deactivate Deactivates the Product Key

Status <text> Can report the following:
• the validity of the Product Key used, 
• the result of activation, 
• and the result of checking the license per 

the interval defined by the licensing mode

Name <text> Reports the marketing code for the licensed 
feature

Description <text> Summarizes the licensed feature

Licensed To # Indicates the device the license applies to

License Key # This character string is used to obtain an 
Activation Key

Expiry MM/YYYY Reports the expiry date for the licensed 
feature

Number of Uses # Represents the amount of docker 
containers set up and running for the 
specific feature

Validity Valid/Invalid Reports if the Activation Key is valid and the 
feature is still licensed or not

Feature ID # Provides the license code that you must 
provide to Ross Technical Support



72 • DashBoard Interface Overview Streaming Gateway User Guide (v8.0)

Timing Tab
The Timing tab provides options for configuring a connection to your facility NTP Server. (Figure 20)

Figure 20  Example of the Timing tab

Table 5 summarizes the fields displayed in the Timing tab.

Table 5  System — Timing
Item Parameters Description

NTP Status 
(read-only)

OK (Green) Indicates a valid time source is reporting to 
the Streaming Gateway

Apply Changes (Yellow) At least one NTP Server address has 
changed. Click Apply to save the new 
setting(s).

Not Running (Red) Software was not able to start NTP client

No Servers Configured 
(Red)

The NTP Server fields are blank

Cannot Resolve Server 
Name (Red)

At least one of the NTP Server host-names 
could not be resolved. It is recommended 
to specify the IP address instead of a 
host-name for the server.

No Time Server Available 
At Address (Red)

At least one NTP Server IP Address does not 
have a valid time server running

Current Time 
(read-only)

Ddd Mmm ## hh : mm : 
ss yyyy GMT

Indicates the encoded date where:
• Ddd represents the day of the week
• Mmm represents the month
• ## represents the day of the month
• hh : mm : ss reports the current encoding 

time as reported by the NTP Server(s)
• yyyy represents the year



Streaming Gateway User Guide (v8.0) DashBoard Interface Overview • 73

Features Tab
The Features tab enables you to monitor the Streaming Gateway features. (Figure 21)

Figure 21  Example of the Features tab

Table 6 summarizes the fields displayed in the Features tab.

NTP Server 1 # Specifies the first Network Time Server 
(NTP) address the Streaming Gateway can 
use for timecode information

NTP Server 2 # Specifies an additional Network Time Server 
(NTP) address the Streaming Gateway can 
use for timecode information

Apply Changes Applies any changes made

Table 6  System — Features
Item Parameters Description

Name <text> The name of the feature

Version # The version of the feature

Hash <text> The hash of the feature

Buildstamp <text> The buildstamp of the feature

State <text> The state of the feature

Restart button Click the button to restart the feature

Table 5  System — Timing (Continued)
Item Parameters Description



74 • DashBoard Interface Overview Streaming Gateway User Guide (v8.0)

About Tab
The About tab reports product information, manage your configuration files, and access the system 
logs. (Figure 22)

Figure 22  Example of the About tab in the System Sub-node

Table 7 summarizes the fields and read-only information displayed in the System > About tab.

Table 7  System — About

Item Parameters Description
Product Information

Serial Number 
(read-only)

# The serial number assigned to the 
Streaming Gateway

Assembly Revision 
(read-only)

# The version of the Streaming Gateway 
hardware 

Product (read-only) softGear Streaming Gateway

Product Version 
(read-only)

<text> The software build the Streaming Gateway 
is currently running

Product Hash 
(read-only)

<text> The hash of the software build

Frame Name <text> Assigns a unique identifier to the Streaming 
Gateway. This name also displays in the 
node for the Streaming Gateway in the Tree 
View of DashBoard. The default is softGear 
Streaming Gateway. Note that any change 
to this name may take up to one minute to 
be reflected in the Tree View of DashBoard.

Hostname 
(read-only)

# Uniquely identifies the Streaming Gateway 
within a WebRTC system

Factory Default Click this button to reset all Streaming Gateway editable fields to the 
factory default values. This impacts all tabs except the Ethernet and 
About tabs. Clicking Factory Default will also trigger a reboot.
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SSG Sub-Node
The SSG sub-node has four main tabs with their own unique interfaces: Connections Control, 
Source Configuration, Destination Configuration, and Configuration tabs.

Connections Control Interface
The Connections Control interface is organized into four areas (from left to right): Connections 
table, Connection Information, Video Source Information, and Audio Channel Mapping. (Figure 23)

Figure 23  Example of the Connections Control Interface

Connections Table

The Connections table reports a list of active and inactive connections that the user has configured 
using the Sources Configuration and Destinations Configuration tabs. Each table row is a 
connection with the assigned Input, Output, and a brief status message. Selecting a row displays 
more information in the Selected Connection area.

Table 8 summarizes the read-only fields displayed in the Connections table.

Import/Export Configuration

Import/Export Click this button to export a configuration file for the Streaming 
Gateway to your computer, or to import a previously saved 
configuration file from your computer to the Streaming Gateway. The 
export option allows you to save the current configuration to a file on 
your computer, while the import button lets you load a previously 
saved configuration file onto the Streaming Gateway. An import will 
trigger a reboot of the Streaming Gateway.
Note: Only configurations that match the feature set of the currently 
licensed system will be imported.

Logs

Download Click this button to download an archive of the logs to a specified 
location on your network or computer

Table 7  System — About (Continued)

Item Parameters Description
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Connection Information

Table 9 summarizes the read-only fields displayed in the Connection Information area. 

For More Information on...
• the available input options, refer to “Source Configuration Interface”.
• the available output options, refer to “Destination Configuration Area”.

Table 8  SSG — Connections Control — Connections Table

Item Description
Name Reports the destination assigned as the output signal for 

the connection

SRC Type Identifies the signal type of the input of the connection 

Type Reports the signal type assigned to the destination

Status Reports the connection status of the stream: online (green), 
offline (gray), or warning (yellow) of an error condition

Online Select this button to enable the selected connection

Offline Select this button to disable the selected connection

Table 9  SSG — Connections Control — Connection Information

Item Parameters Description
Current State Online The connection is active and no errors are 

detected. The connection cannot be edited.

Offline The connection is inactive and can be 
edited

Destination Name <text> Reports the unique identifier assigned to 
the output signal of this connection. Used 
to identify the connection in the Manage 
Connections table.

Destination Type SDI Identifies the output of the connection as 
an SDI signal. Refer to Table 22 for details.

NDI Identifies the output of the connection as 
an NDI signal. Refer to Table 23 for details.

CDI Identifies the output of the connection as a 
CDI signal. Refer to Table 24 for details.

SRT Identifies the output of the connection as 
an SRT signal. Refer to Table 25 for details.

WebRTC Identifies the output of the connection as a 
WebRTC signal. Refer to Table 26 for 
details.

SDI Port <text> When the Destination Type is SDI, this field 
displays and reports which physical 
connection on the back panel is assigned as 
the SDI output for the connection
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Video Source Information

Table 10 summarizes the read-only fields displayed in the Video Source Information area.

NDI Stream Name <text> When the Destination Type is NDI, this field 
displays and reports the network stream 
that is assigned as the output for the 
connection. 
The format of the name displayed will be: 
$HostName($StreamName)

Connection Mode <text> When the Destination Type is SRT, this field 
displays and reports the connection mode 
that is assigned as the output for the 
connection

WebRTC Stream 
Name

<text> When the Destination Type is WebRTC, this 
field displays and reports the network 
stream that is assigned as the output for 
the connection

Audio SRC # Indicates the rate set for Audio SRC in 
Output Audio Settings

Video Format # Indicates the video format of the input 
signal. Displays when Video Scaler is not 
selected.

Resolution # Indicates the resolution set in the Output 
Video Settings. Displays when Video Scaler 
is selected.

Frame Rate # Indicates the frame rate set in the Output 
Video Settings. Displays when Video Scaler 
is selected.

Host:Port # When the Destination Type is SRT and the 
Mode is set to Caller, this field displays and 
indicates the host and port used

Local Port # When the Destination Type is SRT and the 
Mode is set to Listener, this field displays 
and indicates the port used

H.264 H/W 
Acceleration

<text> When the Destination Type is SRT, this field 
displays and reports if H.264 hardware 
acceleration Intel Quick Sync is in use.

Table 10  SSG — Connections Control — Video Source Information

Item Parameters Description
Source Name <text> Reports the unique identifier assigned to 

the input signal of this connection

Source Type SDI Identifies the input of the connection as an 
SDI signal

NDI Identifies the input of the connection as an 
NDI signal

Table 9  SSG — Connections Control — Connection Information (Continued)

Item Parameters Description
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Connection Status Details

Table 11 summarizes the read-only fields displayed in the Connection Status Details area.

Audio Channel Mapping

Table 12 summarizes the read-only fields displayed in the Audio Channel Mapping area.

Source Type SRT Identifies the input of the connection as an 
SRT signal

WebRTC Identifies the input of the connection as a 
WebRTC signal

Source Status Online (Green) The input signal is valid and no errors are 
detected

No input signal detected 
(Yellow)

The specified port is assigned as an input 
but a valid signal is not detected on that 
port

Initializing Signal (Yellow) The Streaming Gateway is in the process of 
establishing a connection 

Closed to Signal Server 
(Yellow)

The input is unavailable. The connection 
with the media server is no longer valid.

Shared Memory Input 
Error (Red)

The input cannot be connected. Toggling 
the Offline and Online buttons may fix this.

Not Initialized (Red) The input is no longer valid. Verify that the 
cable is secured to the port and that a valid 
signal is available on that port.

Packets Missing (Red) The input signal is experiencing errors. 
Verify if a valid signal is connected to the 
port.

Offline (Gray) The stream was stopped or is not yet 
initialized. Verify your network connections.

Source Format # Reports the input video format 

Table 11  Connections Control — Connection Status Details

Item Parameters Description
Feature Name <text> The name of the feature (and its slot) in use

Status (read-only) Reports the status of the connection: online (green), offline (gray), 
warning (yellow), or error (red)

Table 12  SSG — Connections Control — Audio Channel Mapping  (Sheet 1 of 2)

Parameters Description
Channel #

Not in use A source channel is not mapped to the specified 
audio output channel

Table 10  SSG — Connections Control — Video Source Information (Continued)

Item Parameters Description
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Source Configuration Interface
The Source Configuration interface is organized into two areas: Sources table, and Source 
Configuration.

Figure 24  Example of the Source Configuration Interface

Sources Table

The Sources table reports a list of active and inactive sources that the user has configured. 
Double-clicking a row displays more information in the Sources Configuration area.

Table 13 summarizes the read-only fields displayed in the Sources table.

Source Configuration Area

The options that display in the Source Configuration area depend on the Type setting. Table 14 
summarizes the fields that display for all Types. 

<text> Source, Channel # Reports the source audio channel that is mapped to 
the output channel using the options in the 
Destination Configuration interface

Table 13  SSG — Connections Control — Sources

Item Description
Name Reports the source assigned as the input signal for the connection

Type Reports the signal type assigned to the source

Status Reports the connection status of the source: online (green), offline 
(gray), or warning (yellow) of an error condition.

Create Source Select this button to define and add a new source to the database 

Delete Source Select this button to remove the selected source from the database

Table 12  SSG — Connections Control — Audio Channel Mapping (Continued) (Sheet 2 of 2)

Parameters Description
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Table 15 summarizes the options when the Type is set to SDI.

Table 16 summarizes the options when the Type is set to NDI.

Table 17 summarizes the options when the Type is set to CDI.

Table 14  SSG — Source Configuration > All Types

Item Description
Status (read-only) Reports the status of the connection: online (green), offline (gray), 

warning (yellow), or error (red)

Name <text> Identifier assigned to the source connection

Video Format 
(read-only)

# Indicates the video format of the input 
signal

Table 15  SSG — Source Configuration — Type > SDI

Item Parameters Description
Port # Specifies the SDI IN port (on the back panel) 

that the connection will use as the input 
signal. 
The list of available SDI inputs depends on 
the Configuration > Global Settings options.

Table 16  SSG — Source Configuration — Type > NDI

Item Parameters Description
Create NDI Source Selected Allows you to create a new NDI source to 

use. When selected, you must manually 
enter the IP address and port # of the 
desired source.

Cleared Indicates that the source to be used is 
preexisting 

NDI Source <text> Selects an existing source to use as the NDI 
Source

Update

IP Address # Reports the IP address of the selected 
source

Table 17  SSG — Source Configuration — Type > CDI

Item Parameters Description
Port # Specifies the port for the input signal
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Table 18 summarizes the options when the Type is set to SRT.

Table 19 summarizes the options when the Type is set to WebRTC.

Table 18  SSG — Source Configuration — Type > SRT

Item Parameters Description
Latency (ms) # Defines the minimum receiver buffering 

delay before delivering an SRT data packet 
from a receiving SRT socket to stream 
decoder

Mode Listener Indicates the mode for the source is set to 
Listener. 
When in Listener mode, you are listening on 
a port to establish a connection.

Caller Indicates the mode for the source is set to 
Caller. 
When in Caller mode, you are sending out a 
message to the IP and port to connect.

Local Port # Available in Listener Mode. Specifies the 
local port to be used.

Target URL 
(Host:Port)

<text>, # Available in Caller Mode. Specifies the 
target URL and port to be used.

Stream ID <text> Available in Caller Mode. Defines the 
Stream ID.

Encryption Selected Enables data encryption in transit using AES

Cleared Disables data encryption

Key Lengtha

a. Displays only when the Encryption box is selected.

Default Defaults key length to 128-bit to encrypt the 
data

AES-128 Specifies that 128-bit key length is used to 
encrypt the data

AES-192 Specifies that 192-bit key length is used to 
encrypt the data

AES-256 Specifies that 256-bit key length is used to 
encrypt the data

Passphraseb

b. Displays only when the Encryption box is selected.

<text> Determines the passphrase that must be 
matching for both peers, or the connection 
will be rejected by the receiver and fail. 
Passphrase must be 10-80 characters long.

Table 19  SSG — Source Configuration — Type > WebRTC

Item Parameters Description
Stream Name <text> Assigns a unique identifier to the WebRTC 

stream. This name is used by the WebRTC 
client to identify the stream.
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Destination Configuration Interface
The Destination Configuration interface is organized into three areas: Destinations table, 
Destination Configuration, and Audio Channel Mapping.

Figure 25  Example of the Destination Configuration Interface

Destinations Table

The Destinations table reports a list of active and inactive destinations that the user has configured. 
Double-clicking a row displays more information in the Destinations Configuration area. 

Table 20 summarizes the read-only fields displayed in the Destinations table.

Websocket URI # Specifies the Uniform Resource Identifier 
(URI) to use when connecting the Streaming 
Gateway to the remote peer

Websocket Token # Specifies the unique identifier that the 
Streaming Gateway will use for this specific 
WebRTC connection

Has Video Selected Indicates the source has video data

Cleared Indicates the source does not have video 
data

Has Audio Selected Indicates the source has audio data

Cleared Indicates the source does not have audio 
data

Table 20  SSG — Destination Configuration — Destinations Table  (Sheet 1 of 2)

Item Description
Name Reports the destination assigned as the output signal for 

the connection

Src Type Reports the source signal type to this destination

Table 19  SSG — Source Configuration — Type > WebRTC (Continued)

Item Parameters Description
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Destination Configuration Area

The options that display in the Destination Configuration area depend on the Type setting. Table 14 
summarizes the fields that display for all Types.

Table 22 summarizes the options when Type is set to SDI.

Type Reports the signal type assigned to the destination

Status Reports the connection status of the connection: online 
(green), offline (gray), or warning (yellow) of an error 
condition

Create Destination Select this button to define and add a new destination to 
the database 

Delete Destination Select this button to remove the selected destination from 
the database

Table 21  SSG — Destination Configuration > All Types

Item Parameter Description
Status (read-only) Online (green) Reports the status of the connection

Warning (yellow)

Error (red)

Offline (gray)

Name <text> Assigns a unique identifier to the connection

Video Source # Provides a list of the available sources as 
defined using the Sources Configuration tab

Table 22  SSG — Destination Configuration — Type > SDI

Item Parameters Description
Port # Assigns an SDI OUT port (on the back panel) 

to the source. 
The list of available SDI ports depends on 
the Configuration > Global Settings options.

Output Audio Selected The output will include the audio data from 
the selected source. This is the default.

Cleared The source audio data is not included in the 
output signal for this connection

Audio Sample Rate 
Conversion

Selected The sample rate of the audio output will be 
converted to 48k. Only displays when 
Output Audio is selected. 

Cleared The sample rate of the audio output will not 
be converted. Only displays when Output 
Audio is selected. 

Table 20  SSG — Destination Configuration — Destinations Table (Continued) (Sheet 2 of 2)

Item Description
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Table 23 summarizes the options when Type is set to NDI.

AV Sync Selected The output video and audio will be output 
synchronously.
This requires the source video and audio to 
have accurate timestamps.

Cleared The output video and audio will be output 
asynchronously.

Output Video Settings

Output Video Selected The output will include the video data from 
the selected source. This is the default.

Cleared The source video data is not included in the 
output signal for this connection

Video Scalera Selected The video output will be scaled

Cleared The video output will not be scaled

Video Formatb # Selects the desired video format for the 
output. Note that the selected video format 
must match the resolution.

Aspect Ratio 
Controlc

Letterbox/Pillarbox A letterbox will be added to the output 
video when the output aspect ratio is less 
than the input aspect ratio.
A pillarbox will be added to the output 
video when the output aspect ratio is 
greater than the input aspect.
Only applies when the Video Scaler box is 
selected and the output aspect ratio of the 
video scaler is different from the input 
aspect ratio.

Full Frame The output video will be cut to fit in the full 
frame.
Only applies when the Video Scaler box is 
selected and the output aspect ratio of the 
video scaler is different from the input 
aspect ratio.

a. Only displays when Output Video is selected.
b. Only displays when Video Scaler is selected.
c. Only displays when Video Scaler is selected.

Table 23  SSG — Destination Configuration — Type > NDI

Item Parameters Description
Stream Name <text> Assigns a unique identifier to the NDI 

stream

Group Name <text> Publishes the stream in the specified group. 
Receiver has to join the group in order to 
get the stream.

Table 22  SSG — Destination Configuration — Type > SDI (Continued)

Item Parameters Description
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Output Audio Selected The output will include the audio data from 
the selected source. This is the default.

Cleared The source audio data is not included in the 
output signal for this connection

Audio Sample Rate 
Conversiona

Off - 96k The sample rate of the audio output will be 
converted to the rate selected

AV Sync Selected The output video and audio will be output 
synchronously. This requires the source 
video and audio to have accurate 
timestamps.

Cleared The output video and audio will be output 
asynchronously.

Output Video Settings

Output Video Selected The output will include the video data from 
the selected source. This is the default.

Cleared The source video data is not included in the 
output signal for this connection

Deinterlace Selected Enables de-interlacing using linear 
interpolation. 
Only displays when Output Video is 
selected, and the Video Source is set to a 
WebRTC source.

Cleared Disables de-interlacing using linear 
interpolation. 
Only displays when Output Video is 
selected, and the Video Source is set to a 
WebRTC source.

Video Scaler Selected The video output will be scaled. Only 
displays when Output Video is selected.

Cleared The video output will not be scaled. Only 
displays when Output Video is selected.

Resolution # x # Selects the desired resolution for the 
output. Only displays when Video Scaler is 
selected.

Frame/Field Rate # Selects the desired frame rate for the 
output. Only displays when Video Scaler is 
selected.

Table 23  SSG — Destination Configuration — Type > NDI (Continued)

Item Parameters Description
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Table 24 summarizes the options when Type is set to CDI.

Interlaced Selected The video output will be interlaced. 
Only displays when Video Scaler is selected, 
and is only selectable using the following 
Resolution and Frame/Field Rate format 
combinations:
• 640x 480 and 59.94
• 768x576 and 50
• 1920x1080 and 50
• 1920x1080 and 59.94

Cleared The video output will be progressive. 
Only displays when Video Scaler is selected, 
and is only selectable using the following 
Resolution and Frame/Field Rate format 
combinations:
• 640x 480 and 59.94
• 768x576 and 50
• 1920x1080 and 50
• 1920x1080 and 59.94

Aspect Ratio Control Letterbox/Pillarbox A letterbox will be added to the output 
video when the output aspect ratio is less 
than the input aspect ratio.
A pillarbox will be added to the output 
video when the output aspect ratio is 
greater than the input aspect.
Only applies when the video scaler is 
selected and the output aspect ratio of the 
video scaler is different from the input 
aspect ratio.

Full Frame The output video will be cut to fit in the full 
frame.
Only applies when the video scaler is 
selected and the output aspect ratio of the 
video scaler is different from the input 
aspect ratio.

a. Only displays when Output Audio is selected.

Table 24  SSG — Destination Configuration — Type > CDI

Item Parameters Description
IP # Identifies the IP address of the receiver

Port # Assigns the output port to the destination

Table 23  SSG — Destination Configuration — Type > NDI (Continued)

Item Parameters Description
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Output Audio Selected The output will include the audio data from 
the selected source. This is the default.

Cleared The source audio data is not included in the 
output signal for this connection

Audio Sample Rate 
Converter

Off - 96k The sample rate of the audio output will be 
converted to the rate selected. Only 
displays when Output Audio is selected. 

Output ANC Selected The output will include ancillary data from 
the selected source. This is the default.

Cleared The source ancillary data is not included in 
the output signal for this connection

Output Video Settings

Output Video Selected The output will include the video data from 
the selected source. This is the default.

Cleared The source video data is not included in the 
output signal for this connection

Bit-Depth 8 Bit The bit depth of the output will be 8 bit

10 Bit The bit depth of the output will be 10 bit

Video Scaler Selected The video output will be scaled. Only 
displays when Output Video is selected.

Cleared The video output will not be scaled. Only 
displays when Output Video is selected.

Resolution # x # Selects the desired resolution for the 
output. Only displays when Video Scaler is 
selected.

Frame/Field Rate # Selects the desired frame rate for the 
output. Only applies when Video Scaler is 
selected.

Interlaced Selected The video output will be interlaced. 
Only displays when Video Scaler is selected, 
and is only selectable using the following 
Resolution and Frame/Field Rate format 
combinations:
• 640x480 and 59.94
• 768x576 and 50
• 1920x1080 and 50
• 1920x1080 and 59.94

Table 24  SSG — Destination Configuration — Type > CDI (Continued)

Item Parameters Description
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Table 25 summarizes the options when Type is set to SRT.

Interlaced Cleared The video output will be progressive. 
Only displays when Video Scaler is selected, 
and is only selectable using the following 
Resolution and Frame/Field Rate format 
combinations:
• 640x 480 and 59.94
• 768x576 and 50
• 1920x1080 and 50
• 1920x1080 and 59.94

Aspect Ratio Control Letterbox/Pillarbox A letterbox will be added to the output 
video when the output aspect ratio is less 
than the input aspect ratio.
A pillarbox will be added to the output 
video when the output aspect ratio is 
greater than the input aspect.
Only applies when the video scaler is 
selected and the output aspect ratio of the 
video scaler is different from the input 
aspect ratio.

Full Frame The output video will be cut to fit in the full 
frame.
Only applies when the video scaler is 
selected and the output aspect ratio of the 
video scaler is different from the input 
aspect ratio.

Table 25  SSG — Destination Configuration — Type > SRT

Item Parameters Description
Mode Listener Indicates the mode for the source is set to 

Listener. 
When in Listener mode, the Streaming 
Gateway is listening on a port to establish a 
connection.

Caller Indicates the mode for the source is set to 
Caller. 
When in Caller mode, the Streaming 
Gateway sends out a message to the IP 
address and port to connect.

Bandwidth Mode Hardware Limit The Streaming Gateway applies the 
ethernet port bandwidth as the limit

Input Rate Limit The Input Rate and Bandwidth Overhead 
fields are now editable

Manual Limit The Bandwidth Limit field is now editable. 

Table 24  SSG — Destination Configuration — Type > CDI (Continued)

Item Parameters Description
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Bandwidth Limit 
(kbps)

# This field is only editable when the 
Bandwidth Mode is set to Manual Limit. 
Defines the maximum sender bandwidth. 

Bandwidth 
Overhead (%)

# Defines the recovery bandwidth overhead 
percentage. The default is 25%. 
Only applicable when the Bandwidth Mode 
is set to Input Rate Limit.

Local Port # Available in Listener Mode. Specifies the 
local port to be used.

Target URL 
(Host:Port)

<text>, # Available in Caller Mode. Specifies the 
target URL and port to be used.

Stream ID <text> Available in Caller Mode. Defines the 
Stream ID.

Input Rate (kbps) # Defines the anticipated bitrate of your live 
stream. Only applicable when the 
Bandwidth Mode is set to Input Rate Limit.
The default is 0. When set to 0, the value 
used will be estimated from the rate of the 
input during transmission.

Video Stream Settings

Video Source # Provides a list of the available sources as 
defined using the Sources Configuration tab

PID Option Auto The PID value will be automatically set to 
the default one

Custom Allows you to customize the PID value

PID Value # Defines the PID value when the PID Option 
is set to Custom

H264 Encoder

Encoding Profile Main Defines that the H264 profile used will be 
Main

High 4:2:2 Defines that the H264 profile used will be 
High 4:2:2

Video Bit Rate (kbps) CBR, # Defines the video bitrate and its mode, CBR. 
CBR refers to constant bitrate, meaning the 
bitrate will be kept the same.

VBR, # Defines the video bitrate and its mode, VBR. 
VBR refers to variable bitrate, meaning the 
bitrate will vary. The value is the maxiumum 
bitrate allowed.

Video Scaler

Video Scaler Selected The video output will be scaled.

Cleared The video output will not be scaled.

Table 25  SSG — Destination Configuration — Type > SRT (Continued)

Item Parameters Description
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Resolution # x # Selects the desired resolution for the 
output. Only displays when Video Scaler is 
selected.

Frame/Field Rate # Selects the desired frame rate for the 
output. Only displays when Video Scaler is 
selected.

Interlaced Selected The video output will be interlaced. 
Only displays when Video Scaler is selected, 
and is only selectable using the following 
Resolution and Frame/Field Rate format 
combinations:
• 640x 480 and 59.94
• 768x576 and 50
• 1920x1080 and 50
• 1920x1080 and 59.94

Cleared The video output will be progressive. 
Only displays when Video Scaler is selected, 
and is only selectable using the following 
Resolution and Frame/Field Rate format 
combinations:
• 640x 480 and 59.94
• 768x576 and 50
• 1920x1080 and 50
• 1920x1080 and 59.94

Aspect Ratio Control Letterbox/Pillarbox A letterbox will be added to the output 
video when the output aspect ratio is less 
than the input aspect ratio.
A pillarbox will be added to the output 
video when the output aspect ratio is 
greater than the input aspect.
Only applies when the video scaler is 
selected and the output aspect ratio of the 
video scaler is different from the input 
aspect ratio.

Full Frame The output video will be cut to fit in the full 
frame.
Only applies when the video scaler is 
selected and the output aspect ratio of the 
video scaler is different from the input 
aspect ratio.

Encrypt Stream

Encrypt Selected Enables data encryption in transit using AES

Cleared Disables data encryption

Table 25  SSG — Destination Configuration — Type > SRT (Continued)

Item Parameters Description
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Table 26 summarizes the options when the Type is set to WebRTC.

Key Length Default Defaults key length to 128-bit to encrypt the 
data

AES-128 Specifies that 128-bit key length is used to 
encrypt the data

AES-192 Specifies that 192-bit key length is used to 
encrypt the data

AES-256 Specifies that 256-bit key length is used to 
encrypt the data

Passphrase <text> Determines the passphrase that must be 
matching for both peers, or the connection 
will be rejected by the receiver and fail. 
Passphrase must be 10-80 characters long.

Audio Stream Settings

PID Option Auto The PID value will be automatically set to 
the default one

Custom Allows you to customize the PID value

PID Value # Defines the PID value when the PID Option 
is set to Custom

AAC Encoder Bit 
Rate (kbps)

8 - 512 Defines the audio bitrate

Audio Sample Rate 
Converter

Off - 96k The sample rate of the audio output will be 
converted to the rate selected

Output Channels 0-16 Allows you to automatically map the audio 
stream to multiple audio channels

Source <text> The source to use for the audio map

Apply Map Apply the configured number of output channels and source to the 
audio channel map

Table 26  SSG — Destination Configuration — Type > WebRTC

Item Parameters Description
Stream Name <text> Assigns a unique identifier to the WebRTC 

name that is used in DashBoard to label the 
stream

Websocket URI # Specifies the Uniform Resource Identifier 
(URI) to use when connecting the Streaming 
Gateway to the downstream remote peer

Websocket Token # Specifies the unique identifier that the 
Streaming Gateway will use for this output 
WebRTC connection

Table 25  SSG — Destination Configuration — Type > SRT (Continued)

Item Parameters Description
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Audio Channel Mapping

Table 27 summarizes the options displayed in the Audio Channel Mapping area.

Configuration Interface
The Configuration interface displays two sub-tabs on the bottom toolbar: Global Settings and 
About. Each sub-tab is described in this section.

 You may need to scroll down the window to display these sub-tabs.

Output Audio Selected The output will include the audio data from 
the selected source

Cleared The source audio data is not included in the 
output signal for this connection

Output Video Settings

Output Video Selected The output will include the video data from 
the selected source

Cleared The source video data is not included in the 
output signal for this connection

Quality Very Low Indicates the output quality level. The 
default is High. Low

Medium

High

Very High

Drop Frames Selected The Streaming Gateway will automatically 
drop frames when it detects a streaming bit 
rate higher than 2.5Mbps.

Cleared The Streaming Gateway will not drop 
frames even if the bit rate is more than 
2.5Mbps. This is the default.

Table 27  SSG — Destination Configuration — Audio Channel Mapping

Item Parameters Description
Output Channels Slider Use the slider to configure output channels. 

You can configure up to 16 output audio 
channels at once

Source Menu Set the source audio channel

Channel # The output channels.
For CDI and WebRTC there are 2 channels (Ch 1-2).
For SDI, NDI, and SRT there are 16 channels (Ch 1-16).

Source Name <text> Specifies the source name from the 
drop-down menu

Input Channel # Specifies the channel of the source

Table 26  SSG — Destination Configuration — Type > WebRTC (Continued)

Item Parameters Description
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Figure 26  Example of the Configuration Interface

Global Settings Tab

The Global Settings tab enables you to assign a function to the physical connections of the 
Streaming Gateway chassis. The map represents the back panel ports, enabling you to quickly 
select the physical ports to configure.

Table 28 summarizes the options displayed in the Global Settings tab.

Table 28  SSG — Configuration — Global Settings

Item Parameters Description
BNCs

BNC #a Input The physical DIN port is an SDI input. SDI 1, 
3, 5, and 7 are assigned as inputs by default.

Output The physical DIN port is an SDI output. SDI 
2, 4, 6, and 8 are assigned as outputs by 
default.

N/A The physical port is disabled. Displayed 
when operating in the cloud.

SDI Reference 
(read-only)

# Reports the video format detected on the 
REF IN port. Note that if it returns Unknown, 
there is an issue with the reference.

NDI Global Source Discovery

Discovery Group(s) <text> Identifies the NDI Discovery Group(s) used. 
This field is set to Public by default, but 
groups created by users can also be used. 
Multiple Discovery Groups can be used by 
separating them with a comma (e.g. 
Public,Group1,Group2)
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External IP/ 
Hostname

# Identifies the IP address or host name used 
to discover sources when the SSG is 
operating in the cloud. 
Multiple IP addresses can be used by 
separating them with a comma (e.g. 
127.0.0.1,10.0.0.1,10.0.0.2)

Discovery & 
Registration Method

mDNS The Streaming Gateway uses mDNS to 
register sources with other NDI devices on 
the network. This method does not work in 
cloud instances.

Discovery Server The NDI Discovery Server is a tool that 
allows NDI devices to perform discovery. 
The user is required to set up the NDI 
discovery server independently. For 
instructions about setting up the NDI 
discovery server, refer to the NDI SDK 
documentation.

Discovery Server IP/ 
Hostname

# This field identifies the IP address or host 
name for the NDI discovery method. 
After inputting the server IP address or host 
name, the user must reboot their device in 
order to connect to the server.

Status (read-only) OK There is no Discovery Server connected

NDI receiver and sender successfully 
connected to the Discovery server

Apply Changes There are unsaved changes. Click Apply to 
apply the changes.

Status (read-only) Internal error reaching 
discovery server

NDI receiver had an SSG internal error on 
attempting to reach the NDI Discovery 
Server

Lookup failure on 
discovery server name

NDI receiver had a DNS lookup failure for 
NDI Discovery Server

Discovery server not 
reachable

NDI receiver cannot reach the Discovery 
Server

Failure to query 
discovery server

NDI receiver had an internal error querying 
the Discover Server

No response from 
discovery server

NDI receiver connected to the Discovery 
Server but received no response

Unexpected response 
from discovery server

NDI receiver connected to the Discover 
Server but received an unexpected 
response

STUN Server Details

Type <text> Allow the user to manually configure the 
STUN/TURN server details information for 
WebRTC streaming types in DashBoard 
mode

Table 28  SSG — Configuration — Global Settings

Item Parameters Description
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About Tab

Table 29 summarizes the read-only information displayed in the About tab in the SSG sub-node. 

URL <text> The URL used to access the STUN server

Port # The port number used to access the STUN 
server

Username <text> The username used to access the STUN 
server

Password <text> The password used to access the STUN 
server

a. The ports are fixed as follows: Port 1, 3, 5, and 7 are SDI inputs, Ports 2, 4, 6, and 8 are SDI outputs.

Table 29  SSG — Configuration — About

Item Parameters Description
Product Information

SDK Version # Reports information on the SDI IO service 
running on the Streaming Gateway

WebRTC SDK 
Version

# Reports information on the WebRTC service 
running on the Streaming Gateway

Model # Reports the information on the hardware

Hostname # Uniquely identifies the Streaming Gateway 
system

Table 28  SSG — Configuration — Global Settings

Item Parameters Description
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Technical Specifications
This chapter provides technical information for the Streaming Gateway.

 Specifications are subject to change without notice.

Reference Input Specifications

SDI Specifications

1G Specifications
 The Gb2, NET1, and NET2 tabs are not implemented.

 

USB Port Specifications

Environment

Table 30  Technical Specifications — Reference Input

Item Specifications
Connector Type DIN

Table 31  Technical Specifications — SDI

Item Specifications
Number of Inputs 4

Number of Outputs 4

Connector Type DIN

Table 32  Technical Specifications — Gb1

Item Specifications
Standards Accommodated 1000 BASE T

Connector Type RJ45

Table 33  Technical Specifications — USB Port

Item Specifications
Connector Type USB3.0

Table 34  Technical Specifications — Environment 

Item Specifications
Maximum Ambient 
Temperature

40°C (104°F)
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Power
Table 35  Technical Specifications — Power

Item Specifications
Power Supply 350W per power supply

Maximum Power 
Consumption 700W
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Service Information
Routine maintenance to this Ross product is not required. In the event of problems with your 
product, the following basic troubleshooting checklist may help identify the source of the problem. 
If the Streaming Gateway still does not appear to be working properly after checking all possible 
causes, please contact the Technical Support department at the numbers listed in “Contacting 
Ross Video Technical Support”.

1. Visual Review — Performing a quick visual check may reveal many problems, such as 
connectors not properly seated or loose cables. Check the Streaming Gateway, and any 
associated peripheral equipment for signs of trouble.

2. Power Check — Inspect the power indicator LED on the chassis for the presence of power. If 
the power LED is not illuminated, verify that the power cable is connected to a power source 
and that power is available at the power main. If the power LED is still not illuminated, replace 
the power supply with one that is verified to work.

3. Input Signal Status — Verify that source equipment is operating correctly and that a valid 
signal is being supplied.

4. Output Signal Path — Verify that destination equipment is operating correctly and receiving a 
valid signal.

5. Unit Exchange — Exchanging a suspect unit with a unit that is known to be working correctly is 
an efficient method for localizing problems to individual units. 

Exporting a Log File
The Streaming Gateway provides the ability to capture a log file. Entries in this file may relate to 
normal expected functionality or to systemic errors. This information might be useful in monitoring 
and diagnosing a system problem, or when troubleshooting with Ross Technical Support.

To export a log file

1. Display the System sub-node as outlined in “To display the System sub-node in DashBoard”.

2. Select the About tab.

3. Locate the Logs area of the About tab.

4. Click Download.

The Download Logs dialog box appears.

5. Click Browse....

6. Choose the location you want to save the logs to.

7. Enter a File Name for the logs to be saved as.

8. Click Open.

9. Click Download.

The logs will begin to download to the selected location.

 If you try to export logs to the same location as a previously exported and currently opened log 
archive, your download will fail. To avoid this, ensure that no logs are open when exporting new 
ones.
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Warranty and Repair Policy
The Streaming Gateway is warranted to be free of any defect with respect to performance, quality, 
reliability, and workmanship for a period of THREE (3) years from the date of shipment from our 
factory. In the event that your Streaming Gateway proves to be defective in any way during this 
warranty period, Ross Video Limited reserves the right to repair or replace this piece of equipment 
with a unit of equal or superior performance characteristics.

Should you find that this Streaming Gateway has failed after your warranty period has expired, we 
will repair your defective product should suitable replacement components be available. You, the 
owner, will bear any labor and/or part costs incurred in the repair or refurbishment of said 
equipment beyond the THREE (3) year warranty period.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or 
consequential damages (including loss of profits) incurred by the use of this product. Implied 
warranties are expressly limited to the duration of this warranty.

This User Manual provides all pertinent information for the safe installation and operation of your 
Streaming Gateway. Ross Video policy dictates that all repairs to the Streaming Gateway are to be 
conducted only by an authorized Ross Video Limited factory representative. Therefore, any 
unauthorized attempt to repair this product, by anyone other than an authorized Ross Video 
Limited factory representative, will automatically void the warranty. Please contact Ross Video 
Technical Support for more information.

In Case of Problems

Should any problem arise with your Streaming Gateway, please contact the Ross Video Technical 
Support Department. (Contact information is supplied at the end of this publication.)

A Return Material Authorization number (RMA) will be issued to you, as well as specific shipping 
instructions, should you wish our factory to repair your Streaming Gateway. If required, a 
temporary replacement Streaming Gateway will be made available at a nominal charge. Any 
shipping costs incurred will be the responsibility of you, the customer. All products shipped to you 
from Ross Video Limited will be shipped collect. 

The Ross Video Technical Support Department will continue to provide advice on any product 
manufactured by Ross Video Limited, beyond the warranty period without charge, for the life of the 
equipment.
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Glossary
The following terms are used throughout this guide:

AES — refers to Advanced Encryption Standard.

Amazon EC2 — refers to Amazon Elastic Compute Cloud.

Audio SRC — refers to Audio Sample Rate Converter.

AWS — refers to Amazon Web Services.

DashBoard — refers to the DashBoard Control System.

Destination — refers to the output.

Device View — refers to the area located to the far right of the DashBoard window. This area 
typically displays tabs that include menus and options for control and monitoring your devices.

DHCP — refers to Dynamic Host Configuration Protocol.

EFA — refers to Elastic Fabric Adapter.

NTP — refers to Network Time Protocol.

Operator and User — refer to the person who uses the Streaming Gateway.

RPM — refers to the Ross Platform Manager.

Source — refers to the input.

Tree View — refers to the area located to the far left of the DashBoard window. This area displays 
devices in a tree structure. 

URI — refers to Uniform Resource Identifier.

WebRTC — refers to Web Real-Time Communication.
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Third Party Licenses
This chapter contains licenses for third party libraries that are used in the softGear Streaming 
Gateway.

dbus 
Copyright (c) 2013, Georg Reinke (<guelfey at gmail dot com>), Google

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

dhkx 
Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

“License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of 
this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under 
common control with that entity. For the purposes of this definition,  "control" means (i) the power, direct or indirect, to 
cause the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) 
or more of the outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications, including but not limited to software source code, 
documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but 
not limited to compiled object code, generated documentation, and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated 
by a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and 
for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of 
authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely 
link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or 
additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by 
the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the 
purposes of this definition, "submitted" means any form of electronic, verbal, or written communication sent to the Licensor 
or its representatives, including but not limited to communication on electronic mailing lists, source code control systems, 
and issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving 
the Work, but excluding communication that is conspicuously marked or otherwise designated in writing by the copyright 
owner as "Not a Contribution."
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"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by 
Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. 

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, 
non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly 
display, publicly perform, sub license, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. 

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, 
non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to make, have made, use, 
offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those patent claims licensable 
by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) 
with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity (including a 
cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work constitutes 
direct or contributory patent infringement, then any patent licenses granted to You under this License for that Work shall 
terminate as of the date such litigation is filed.

4. Redistribution. 

You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without 
modifications, and in Source or Object form, provided that You meet the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and 

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and 

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and 
attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the 
Derivative Works; and 

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute must 
include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not 
pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text file distributed as part 
of the Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or,           
within a display generated by the Derivative Works, if and wherever such third-party notices normally appear. The contents 
of the NOTICE file are for informational purposes only and do not modify the License. You may add Your own attribution 
notices within Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, 
provided that such additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and       may provide additional or different license terms 
and conditions      for use, reproduction, or distribution of Your modifications, or      for any such Derivative Works as a whole, 
provided Your use,      reproduction, and distribution of the Work otherwise complies with      the conditions stated in this 
License.

5. Submission of Contributions. 

Unless You explicitly state otherwise,       any Contribution intentionally submitted for inclusion in the Work       by You to the 
Licensor shall be under the terms and conditions of       this License, without any additional terms or conditions.       
Notwithstanding the above, nothing herein shall supersede or modify       the terms of any separate license agreement you 
may have executed       with Licensor regarding such Contributions.

6. Trademarks. 

This License does not grant permission to use the trade names, trademarks, service marks, or product names of the 
Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the 
content of the NOTICE file.

7. Disclaimer of Warranty. 

Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each Contributor provides its 
Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or  implied, 
including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS 
FOR A  PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the 
Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. 

In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise,  unless required by 
applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for 
damages, including any direct, indirect, special, incidental, or consequential damages of any character arising as a result of 
this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill,  work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has 
been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. 

While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of 
support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting 
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such obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other 
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or 
claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

 APPENDIX: How to apply the Apache License to your work.

 To apply the Apache License to your work, attach the following boilerplate notice, with the fields enclosed by brackets "[]" 
replaced with your own identifying information. (Don't include the brackets!) The text should be enclosed in the appropriate 
comment syntax for the file format. We also recommend that a file or class name and description of purpose be included on 
the same "printed page" as the copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the 
License.   You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software   distributed under the License is distributed on an "AS IS" 
BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.  See the License for the specific 
language governing permissions and   limitations under the License.

Docker
                                 Apache License

                           Version 2.0, January 2004

                        http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of 
this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under 
common control with that entity. For the purposes of this definition, "control" means (i) the power, direct or indirect, to cause 
the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or 
more of the      outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications, including but not limited to software source code, 
documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but 
not limited to compiled object code, generated documentation, and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated 
by a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and 
for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of 
authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely 
link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or 
additions to that Work or Derivative Works thereof, that is intentionally      submitted to Licensor for inclusion in the Work by 
the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the 
purposes of this definition, "submitted" means any form of electronic, verbal, or written communication sent to the Licensor 
or its representatives, including but not limited to communication on electronic mailing lists, source code control systems, 
and issue tracking systems that are managed by, or on behalf of, the      Licensor for the purpose of discussing and improving 
the Work, but excluding communication that is conspicuously marked or otherwise designated in writing by the copyright 
owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by 
Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. 

Subject to the terms and conditions of   this License, each Contributor hereby grants to You a perpetual, worldwide, 
non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly 
display, publicly perform, sub license, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. 

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, 
non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to make, have made, use, 



106 • Third Party Licenses Streaming Gateway User Guide (v8.0)

offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those patent claims licensable 
by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) 
with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity (including a 
cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work constitutes 
direct or contributory patent infringement, then any patent licenses granted to You under this License for that Work shall 
terminate as of the date such litigation is filed.

4. Redistribution. 

You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without 
modifications, and in Source or Object form, provided that You meet the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and 
attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the 
Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute must 
include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not 
pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text file distributed as part 
of the Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or,          
within a display generated by the Derivative Works, if and wherever such third-party notices normally appear. The contents 
of the NOTICE file are for informational purposes only and do not modify the License. You may add Your own attribution 
notices within Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, 
provided that such additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or different license terms and 
conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole, provided 
Your use, reproduction, and distribution of the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. 

Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by You to the 
Licensor shall be under the terms and conditions of this License, without any additional terms or conditions. 
Notwithstanding the above, nothing herein shall supersede or modify the terms of any separate license agreement you may 
have executed with Licensor regarding such Contributions.

6. Trademarks. 

This License does not grant permission to use the trade names, trademarks, service marks, or product names of the 
Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the 
content of the NOTICE file.

7. Disclaimer of Warranty. 

Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each      Contributor provides its 
Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, 
including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS 
FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the 
Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. 

In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise,      unless required by 
applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for 
damages, including any direct, indirect, special,      incidental, or consequential damages of any character arising as a result of 
this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill,      work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has 
been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. 

While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of 
support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting 
such obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other 
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or 
claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields enclosed by brackets "[]" 
replaced with your own identifying information. (Don't include the brackets!) The text should be enclosed in the appropriate 
comment syntax for the file format. We also recommend that a file or class name and description of purpose be included on 
the same "printed page" as the copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]
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Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the 
License. You may obtain a copy of the License at    http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS" 
BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.   See the License for the specific 
language governing permissions and    limitations under the License.

WebRTC
FILENAME: LICENSE

============================

Copyright (c) 2011, The WebRTC project authors. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the     distribution.

* Neither the name of Google nor the names of its contributors may be used to endorse or promote products derived from 
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

Haivision SRT
Mozilla Public License Version 2.0

==================================

1. Definitions

--------------

1.1. "Contributor" means each individual or legal entity that creates, contributes to the creation of, or owns Covered 
Software.

1.2. "Contributor Version" means the combination of the Contributions of others (if any) used by a Contributor and that 
particular Contributor's Contribution.

1.3. "Contribution" means Covered Software of a particular Contributor.

1.4. "Covered Software" means Source Code Form to which the initial Contributor has attached    the notice in Exhibit A, the 
Executable Form of such Source Code Form, and Modifications of such Source Code Form, in each case including portions 
thereof.

1.5. "Incompatible With Secondary Licenses" means (a) that the initial Contributor has attached the notice described in 
Exhibit B to the Covered Software; or (b) that the Covered Software was made available under the terms of version 1.1 or 
earlier of the License, but not also under the terms of a Secondary License.

1.6. "Executable Form" means any form of the work other than Source Code Form. 

1.7. "Larger Work" means a work that combines Covered Software with other material, in      a separate file or files, that is not 
Covered Software.

1.8. "License" means this document.

1.9. "Licensable" means having the right to grant, to the maximum extent possible, whether at the time of the initial grant or 
subsequently, any and     all of the rights conveyed by this License.

1.10. "Modifications" means any of the following:

(a) any file in Source Code Form that results from an addition to, deletion from, or modification of the contents of Covered 
Software; or 

(b) any new file in Source Code Form that contains any Covered Software.

1.11. "Patent Claims" of a Contributor means any patent claim(s), including without limitation, method,     process, and 
apparatus claims, in any patent Licensable by such Contributor that would be infringed, but for the grant of the License, by 
the making, using, selling, offering for sale, having     made, import, or transfer of either its Contributions or its Contributor 
Version.
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1.12. "Secondary License" means either the GNU General Public License, Version 2.0, the GNU    Lesser General Public 
License, Version 2.1, the GNU Affero General Public License, Version 3.0, or any later versions of those licenses.

1.13. "Source Code Form" means the form of the work preferred for making modifications.

1.14. "You" (or "Your") means an individual or a legal entity exercising rights under this    License. For legal entities, "You" 
includes any entity that controls, is controlled by, or is under common control with You. For purposes of this definition, 
"control" means (a) the power, direct    or indirect, to cause the direction or management of such entity, whether by contract 
or otherwise, or (b) ownership of more than fifty percent (50%) of the outstanding shares or beneficial    ownership of such 
entity.

2. License Grants and Conditions

--------------------------------

2.1. Grants

Each Contributor hereby grants You a world-wide, royalty-freestone-exclusive license:

(a) under intellectual property rights (other than patent or trademark) Licensable by such Contributor to use, reproduce, 
make available, modify, display, perform, distribute, and otherwise exploit its Contributions, either on an unmodified basis, 
with Modifications, or as part of a Larger Work; and

(b) under Patent Claims of such Contributor to make, use, sell, offer for sale, have made, import, and otherwise transfer 
either its Contributions or its Contributor Version.

2.2. Effective Date

The licenses granted in Section 2.1 with respect to any Contribution become effective for each Contribution on the date the 
Contributor first distributes such Contribution.

2.3. Limitations on Grant Scope

The licenses granted in this Section 2 are the only rights granted under this License. No additional rights or licenses will be 
implied from the distribution or licensing of Covered Software under this License.

Notwithstanding Section 2.1(b) above, no patent license is granted by a Contributor:

(a) for any code that a Contributor has removed from Covered Software; or

(b) for infringements caused by: (i) Your and any other third party's modifications of Covered Software, or (ii) the 
combination of its Contributions with other software (except as part of its Contributor Version); or

(c) under Patent Claims infringed by Covered Software in the absence of its Contributions.

This License does not grant any rights in the trademarks, service marks, or logos of any Contributor (except as may be 
necessary to comply with the notice requirements in Section 3.4).

2.4. Subsequent Licenses

No Contributor makes additional grants as a result of Your choice to distribute the Covered Software under a subsequent 
version of this License (see Section 10.2) or under the terms of a Secondary License (if permitted under the terms of Section 
3.3).

2.5. Representation

Each Contributor represents that the Contributor believes its Contributions are its original creation(s) or it has sufficient 
rights to grant the rights to its Contributions conveyed by this License.

2.6. Fair Use

This License is not intended to limit any rights You have under applicable copyright doctrines of fair use, fair dealing, or other 
equivalents.

2.7. Conditions

Sections 3.1, 3.2, 3.3, and 3.4 are conditions of the licenses granted in Section 2.1.

3. Responsibilities

-------------------

3.1. Distribution of Source Form

All distribution of Covered Software in Source Code Form, including any Modifications that You create or to which You 
contribute, must be under the terms of this License. You must inform recipients that the Source Code Form of the Covered 
Software is governed by the terms of this License, and how they can obtain a copy of this License. You may not attempt to 
alter or restrict the recipients' rights in the Source Co Deform.

3.2. Distribution of Executable Form

If You distribute Covered Software in Executable Form then:

(a) such Covered Software must also be made available in Source Code Form, as described in Section 3.1, and You must 
inform recipients of the Executable Form how they can obtain a copy of such Source Code Form by reasonable means in a 
timely manner, at a charge no more than the cost of distribution to the recipient; and
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(b) You may distribute such Executable Form under the terms of this License, or sub license it under different terms, 
provided that the license for the Executable Form does not attempt to limit or alter    the recipients' rights in the Source Code 
Form under this License.

3.3. Distribution of a Larger Work

You may create and distribute a Larger Work under terms of Your improvidence that You also comply with the requirements 
of this License forth Covered Software. If the Larger Work is a combination of Covered Software with a work governed by one 
or more Secondary Licenses, and the Covered Software is not Incompatible With Secondary Licenses, this License permits 
You to additionally distribute such Covered Software under the terms of such Secondary License(s), so that the recipient of 
the Larger Work may, at their option, further distribute the Covered Software under the terms of either this License or such 
Secondary License(s).

3.4. Notices

You may not remove or alter the substance of any license notices (including copyright notices, patent notices, disclaimers of 
warranty limitations of liability) contained within the Source Code Form of the Covered Software, except that You may alter 
any license notices tithe extent required to remedy known factual inaccuracies.

3.5. Application of Additional Terms

You may choose to offer, and to charge a fee for, warranty, supportability or liability obligations to one or more recipients of 
Covered Software. However, You may do so only on Your own behalf, and not on behalf of any Contributor. You must make 
it absolutely clear that any such warranty, support, indemnity, or liability obligation is offered by You alone, and You hereby 
agree to indemnify every Contributor for any liability incurred by such Contributor as a result of warranty, supportability or 
liability terms You offer. You may include additional disclaimers of warranty and limitations of liability specific to any 
jurisdiction.

4. Inability to Comply Due to Statute or Regulation

---------------------------------------------------

If it is impossible for You to comply with any of the terms of this License with respect to some or all of the Covered Software 
due to statute, judicial order, or regulation then You must: (a) comply withe terms of this License to the maximum extent 
possible; and (b) describe the limitations and the code they affect. Such description must be placed in a text file included with 
all distributions of the Covered Software under this License. Except to the extent prohibited by statute or regulation, such 
description must be sufficiently detailed for recipient of ordinary skill to be able to understand it.

5. Termination

--------------

5.1. The rights granted under this License will terminate automatically if You fail to comply with any of its terms. However, if 
You become compliant, then the rights granted under this License from a particular Contributor are reinstated (a) 
provisionally, unless and until such Contributor explicitly and finally terminates Your grants, and (b) on an ongoing basis, if 
such Contributor fails to notify You of the non-compliance by some reasonable means prior to 60 days after You have come 
back into compliance. Moreover, Your grants from a particular Contributor are reinstated on an ongoing basis if such 
Contributor notifies You of the non-compliance by some reasonable means, this is the first time You have received notice of 
non-compliance with this License from such Contributor, and You become compliant prior to 30 days after Your receipt of 
the notice.

5.2. If You initiate litigation against any entity by asserting a patent infringement claim (excluding declaratory judgment 
counteraction-claims, and cross-claims) alleging that a Contributor Version directly or indirectly infringes any patent, then 
the rights granted to You by any and all Contributors for the Covered Software under Section2.1 of this License shall 
terminate.

5.3. In the event of termination under Sections 5.1 or 5.2 above, all end user license agreements (excluding distributors and 
resellers) which have been validly granted by You or Your distributors under this License prior to termination shall survive 
termination.

************************************************************************

* 6. Disclaimer of Warranty                                           *

* -------------------------                                           *

* Covered Software is provided under this License on an "as is" basis, without warranty of any kind, either expressed, 
implied, or statutory, including, without limitation, warranties that the Covered Software is free of defects, merchantable, fit 
for a particular purpose or non-infringing. The entire risk as to the quality and performance of the Covered Software is with 
You.

* Should any Covered Software prove defective in any respect, You (not any Contributor) assume the cost of any necessary 
servicing, repair, or correction. This disclaimer of warranty constitutes an    essential part of this License. No use of any 
Covered Software is authorized under this License except under this disclaimer.   

*                                                                      *

************************************************************************

************************************************************************
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7. Limitation of Liability                                          *

* --------------------------                                          *

* Under no circumstances and under no legal theory, whether tort (including negligence), contract, or otherwise, shall any 
Contributor, or anyone who distributes Covered Software as permitted above, be liable to You for any direct, indirect, 
special, incidental, or consequential damages of any character including, without limitation, damages for lost profits, loss of 
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages or losses, even if such 
party shall have been informed of the possibility of such damages. This limitation of liability shall not apply to liability for 
death or personal injury resulting from such party's negligence to the extent applicable law prohibits such limitation. Some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so this exclusion and limitation 
may not apply to You.                                    *                                                                      *

************************************************************************

8. Litigation

-------------

Any litigation relating to this License may be brought only in the courts of a jurisdiction where the defendant maintains its 
principal place of business and such litigation shall be governed by laws of that jurisdiction, without reference to its 
conflict-of-law provisions.

Nothing in this Section shall prevent a party's ability to bring cross-claims or counter-claims.

9. Miscellaneous

----------------

This License represents the complete agreement concerning the subject matter hereof. If any provision of this License is held 
to be unenforceable, such provision shall be reformed only to the extent necessary to make it enforceable. Any law or 
regulation which provides that the language of a contract shall be construed against the drafter shall not be used to construe 
this License against a Contributor.

10. Versions of the License

---------------------------

10.1. New Versions

Mozilla Foundation is the license steward. Except as provided in Section10.3, no one other than the license steward has the 
right to modify or publish new versions of this License. Each version will be given distinguishing version number.

10.2. Effect of New Versions

You may distribute the Covered Software under the terms of the version of the License under which You originally received 
the Covered Software under the terms of any subsequent version published by the license steward.

10.3. Modified Versions

If you create software not governed by this License, and you want to create a new license for such software, you may create 
and use modified version of this License if you rename the license and remove any references to the name of the license 
steward (except to note that such modified license differs from this License).

10.4. Distributing Source Code Form that is Incompatible With Secondary Licenses

If You choose to distribute Source Code Form that is Incompatible With Secondary Licenses under the terms of this version 
of the License, the notice described in Exhibit B of this License must be attached.

Exhibit A - Source Code Form License Notice

-------------------------------------------

This Source Code Form is subject to the terms of the Mozilla Public License, v. 2.0. If a copy of the MPL was not distributed 
with this file, You can obtain one at http://mozilla.org/MPL/2.0/.

If it is not possible or desirable to put the notice in a particular file, then You may include the notice in a location (such as a 
License file in a relevant directory) where a recipient would be likely to look for such a notice.

You may add additional accurate notices of copyright ownership.

Exhibit B - "Incompatible With Secondary Licenses" Notice

---------------------------------------------------------

This Source Code Form is "Incompatible With Secondary Licenses", as defined by the Mozilla Public License, v. 2.0.

httprouter 
BSD 3-Clause License

Copyright (c) 2013, Julien Schmidt

All rights reserved.
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Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this   list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,   this list of conditions and the following 
disclaimer in the documentation   and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its   contributors may be used to endorse or promote products 
derived from   this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THEIMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE AREDISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLEFOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIALDAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS ORSERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVERCAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USEOF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

IXWebSocket
Copyright (c) 2018 Machine Zone, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the   documentation and/or other materials provided with the   distribution.

3. Neither the name of the copyright holder nor the names of its contributors may be used to endorse or promote products 
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHTHOLDER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOTLIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

libsamplerate
Copyright (c) 2012-2016, Erik de Castro Lopo <erikd@mega-nerd.com>

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
APARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

mongo-driver
                                 Apache License

                           Version 2.0, January 2004

                        http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.
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"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of 
this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under 
common control with that entity. For the purposes of this definition, "control" means (i) the power, direct or indirect, to cause 
the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or 
more of the outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications, including but not limited to software source code, 
documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but 
not limited to compiled object code, generated documentation, and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated 
by a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and 
for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of 
authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely 
link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or 
additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by 
the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the 
purposes of this definition, "submitted" means any form of electronic, verbal, or written communication sent to the Licensor 
or its representatives, including but not limited to communication on electronic mailing lists, source code control systems, 
and issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving 
the Work, but excluding communication that is conspicuously marked or otherwise designated in writing by the copyright 
owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by 
Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. 

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, 
non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly 
display, publicly perform, sub license, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. 

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, 
non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to make, have made, use, 
offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those patent claims licensable 
by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s)      
with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity (including a 
cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work constitutes 
direct or contributory patent infringement, then any patent licenses granted to You under this License for that Work shall 
terminate as of the date such litigation is filed.

4. Redistribution. 

You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without 
modifications, and in Source or Object form, provided that You meet the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and 
attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the 
Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute must 
include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not 
pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text file distributed as part 
of the Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or, within a 
display generated by the Derivative Works, if and wherever such third-party notices normally appear. The contents of the 
NOTICE file are for informational purposes only and do not modify the License. You may add Your own attribution notices 
within Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, provided that 
such additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or different license terms and 
conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole, provided 
Your use, reproduction, and distribution of the Work otherwise complies with the conditions stated in this License.
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5. Submission of Contributions. 

Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by You to the 
Licensor shall be under the terms and conditions of this License, without any additional terms or conditions. 
Notwithstanding the above, nothing herein shall supersede or modify the terms of any separate license agreement you may 
have executed with Licensor regarding such Contributions.

6. Trademarks. 

This License does not grant permission to use the trade names, trademarks, service marks, or product names of the 
Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the 
content of the NOTICE file.

7. Disclaimer of Warranty. 

Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each Contributor provides its 
Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, 
including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS 
FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the 
Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. 

In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise, unless required by 
applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for 
damages, including any direct, indirect, special,      incidental, or consequential damages of any character arising as a result of 
this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill, work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has 
been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. 

While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of 
support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting 
such obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other 
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or 
claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields enclosed by brackets "[]" 
replaced with your own identifying information. (Don't include the brackets!. The text should be enclosed in the appropriate 
comment syntax for the file format. We also recommend that a file or class name and description of purpose be included on 
the same "printed page" as the copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the 
License. You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS" 
BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the License for the specific 
language governing permissions and limitations under the License.

nlohmann/json
MIT License 

Copyright (c) 2013-2022 Niels Lohmann

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation 
files (the "Software"), to dealing the Software without restriction, including without limitation the rights to use, copy, modify, 
merge, publish, distribute, sub license, and/or sell copies of the Software, and to permit persons to whom the Software is 
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS ORIMPLIED, INCLUDING BUT NOT 
LIMITED TO THE WARRANTIES OF MERCHANTABILITY,FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO 
EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER 
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,OUT OF OR IN CONNECTION WITH THE SOFTWARE OR 
THE USE OR OTHER DEALINGS IN THE SOFTWARE.

OpenSLP
The following copyright and license is applicable to the entire OpenSLP project (libslp, slpd, and related documentation):

Copyright © 2000 Caldera Systems, Inc
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All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer 
in the documentation and/or other materials provided with the distribution.

Neither the name of Caldera Systems nor the names of its contributors may be used to endorse or promote products 
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE CALDERA SYSTEMS OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

spdlog
The MIT License (MIT)

Copyright (c) 2016 Gabi Melman.                                       

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation 
files (the "Software"), to dealing the Software without restriction, including without limitation the rights to use, copy, modify, 
merge, publish, distribute, sub license, and/or sell copies of the Software, and to permit persons to whom the Software is 
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON INFRINGEMENT. IN 
NO EVENT SHALL THEAUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, 
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,OUT OF OR IN CONNECTION WITH THE 
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

-- NOTE: Third party dependency used by this software --

This software depends on the fmt lib (MIT License), and users must comply to its license: 
https://github.com/fmtlib/fmt/blob/master/LICENSE.rst

zmq4
Copyright (c) 2013-2018, Peter Kleiweg

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the   documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "ASIS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITEDTO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
APARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, ORPROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OFLIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THISSOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.
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